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Petunjuk Umum 

 
 

Aksi yang dilakukan pada Mouse: 

1.  : Klik (klik satu kali) 

2.  : Klik Ganda (klik dua kali tombol kiri mouse) 

3. → : Klik dan Tarik (Click and drag, klik tombol kiri mouse lanjutkan dengan 

menggeser) 

4. R : Klik Kanan (klik satu kali tombol kanan mouse) 

 

Aksi yang dilakukan pada Keyboard: 

1.     : Tekan tombol logo Windows pada keyboard 

2.     : Tekan tombol Shift pada keyboard 

3.     : Tekan tombol Enter pada keyboard 

4.    : Ketik (ketikan pada keyboard) 

5. CTRL+S  : Control S (tekan tombol “Ctrl”, tahan dan lanjutkan 

menekan tombol “S” secara bersamaan pada keyboard) 

 

Aksi yang dilakukan pada Keyboard: 

1.   : Baca (user membaca output, informasi, konfirmasi dari layar 

komputer) 
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BAB I    PENCARIAN DI INTERNET & GMAIL 

  

 

Topik Utama 

✓ Mahasiswa memahami keuntungan penggunaan internet 

✓ Mahasiswa mengetahui kemampuan website search engine 

✓ Mahasiswa mengenal istilah-istilah nama domain, sub domain, 

alamat URL, Top Level Domain (TLD), dan Sub Level Domain 

(SLD) 

✓ Mahasiswa mengenal fitur-fitur dasar dari salah satu website 

search engine yang ada di internet yaitu Google 

✓ Mahasiswa mahir menggunakan sintak-sintak yang digunakan 

didalam keyword 

✓ Mahasiswa memiliki akun Google Mail 

 

 

Hubungan dengan Bab lainnya 

✓ Bab II yang membahas Cloud Computing & Google Apps 

 

 

Pertanyaan Umum 

✓ Apa fungsi dari website search engine? 

✓ Website search engine selain Google? 

✓ Bagaimanakah mengkombinasikan beberapa sintak dalam satu 

keyword? 

✓ Apa saja manfaat memiliki akun Google Mail (Gmail) 

 

Praktikum  Membuka fitur-fitur dasar Google 

 Mencoba satu persatu sintak keyword 

 Memperhatikan hasil pencarian dari setiap keyword yang dimasukkan 

 Menguasai kombinasi sintak-sintak keyword 

 Membuat akun Gmail 
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A. SEARCH ENGINE 

Internet Searching merupakan salah satu keterampilan penggunaan dan pencarian 

informasi di internet untuk mendukung pekerjaan. Searching penting dikuasai oleh pengguna 

internet dalam hal membantu dan mempercepat informasi yang ingin diketahui. Namun, 

keterampilan ini tidak banyak diperhatikan oleh setiap pengguna internet sehingga ketika 

pengguna berusaha mencari informasi yang ingin didapatkannya, pengguna menjadi berputar-

putar tanpa mendapatkan informasi yang diinginkannya. Ada beberapa search engine yang 

terkenal, yaitu Google, Bing, Yahoo, Ask.com, dan lain-lain. 

Di dalam modul ini, pencarian informasi yang diambil adalah menggunakan Google, 

karena harus diakui Google merupakan search engine yang paling banyak dipakai oleh 

pengguna internet. Beragam informasi dapat kita cari secara cepat dengan menggunakan 

Google. Untuk mengoptimalkan hasil pencarian, Google menyediakan beberapa kelebihan 

yang akan kita bahas sebagian didalam modul ini. 

Pengertian  

Nama Domain, 

Sub Domain, 

Nama domain biasanya disebut pula dengan istilah URL (Uniform 

Resource Locator), atau alamat website. 

Alamat URL. Sedangkan secara teknis: 

Definisi Nama Domain 

(domain name) adalah nama unik yang diberikan untuk 

mengidentifikasi nama server komputer seperti web server atau e-mail 

server di jaringan komputer ataupun internet. 

Fungsi Nama Domain: 

Yaitu untuk mempermudah pengguna di internet pada saat melakukan 

akses ke server, selain juga dipakai untuk mengingat nama server yang 

dikunjungi tanpa harus mengenal deretan angka yang rumit yang 

dikenal sebagai IP address. 

 Contoh Nama Domain: 

www.google.com, www.google.co.id, www.stietrisakti.ac.id, 

www.un.org 

Contoh sub domain: 

images.google.com, https://ibank.klikbca.com 

Contoh alamat URL: 

http://en.wikipedia.org/wiki/Indonesia, 

www.unicef.org/infobycountry/indonesia.html 

 Source: http://id.wikipedia.org/wiki/Nama_domain (Juli 2009) 

1. Membuka search engine Google dan fitur-fitur dasar Google 

Berikut beberapa teknik dalam mencari informasi di internet dengan menggunakan 

website search engine: 

 

http://id.wikipedia.org/wiki/Nama_domain
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1. Buka program Google Chrome. 

2. Kemudian ketikkan www.google.com atau langsung google.com (tanpa mengetik www.) 

lanjutkan dengan menekan tombol ENTER pada keyboard. 

3. Maka akan tampil halaman depan website Google seperti pada gambar dibawah ini:  

 
Gambar 1. tampilan halaman depan website google.com (versi bahasa Inggris) 

 
Gambar 2. tampilan halaman depan website google.com (versi bahasa Indonesia) 

4. Beberapa fitur didalam menu yang bisa kita temukan didalam Google, diantaranya adalah: 

a. + You (Goggle+): Layanan jejaring sosial yang disediakan oleh Google 

b. Web: Pencarian informasi isi teks didalam website dengan menggunakan keywords 

Secara temporer logo 

Google biasanya 

berubah-ubah sesuai 

historis hari tersebut. 



Trisakti School of Management  

Data Modeling and Visualization Laboratory/P24.25 

Hanya untuk digunakan di lingkungan TSM!  Page 11 of 178 

c. Images: pencarian gambar dari situs-situs di internet 

d. Play: daftar instalasi software permainan untuk android/tab 

e. News: daftar berita terkini lokal/internasional 

f. YouTube: Pencarian video online 

g. Drive: tempat penyimpanan file secara online (cloud computing) 

h. Groups: pencarian isi pembahasan yang dilakukan didalam forum 

i. Books: pencarian isi informasi didalam sebuah buku elektronik (e-Books) 

j. Scholar (Google Cendekia): pencarian informasi atau artikel ilmiah didalam website 

k. Blogs: pencarian informasi khusus yang terkandung didalam blog seseorang 

l. Photos: pencarian foto yang diupload oleh seseorang, 

m. Fitur lainnya adalah; penggantian bahasa, Maps, translate, Mobile, Offer, Wallet, 

Shoping, Finance, Video, calendar, documents, dll... 

 

Berikut kita akan coba memulai menggunakan pencarian informasi dengan 

menggunakan Google. 

1. Sebagai contoh awal, pada halaman Google ketikkan keyword berikut ini dengan 

memperhatikan huruf kapitalnya: 

a. Global WARMING > lanjutkan tekan tombol Enter pada keyboard 

• Perhatikan hasil pencarian. 

b. global warming > Enter 

• Perhatikan hasil pencarian. 

c. GLOBAL WARMING > Enter 

• Perhatikan hasil pencarian. 

d. Global Warming > Enter 

• Perhatikan hasil pencarian. 

e. gLoBaL WaRmInG > Enter 

• Perhatikan hasil pencarian. 

f. Warming global > Enter 

• Perhatikan hasil pencarian. 

2. Dari hasil pencarian tersebut, kita bisa menyimpulkan bahwa Google tidak "case sensitive" 

yaitu karakter kapital atau tidak yang kita masukkan didalam keyword tidak 

mempengaruhi kandungan pencarian.  Seperti contoh: 

Global WARMING = global warming = GLOBAL WARMING = Global Warming = 

gLoBaL WaRmInG = warming global. 

2. Mencari definisi dari keyword yang dimasukkan (define:) 

Fungsi dari kode keyword ini adalah untuk mencari definisi dari sebuah kata atau frase. 

Dan perlu diketahui bahwa semua kata yang diketik setelah kode define: akan dianggap sebagai 

sebuah frase. Formatnya: 

Define:keyword 

 

Lakukanlah contoh pencarian definisi seperti dibawah ini: 

• Buka program Google Chrome 
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• Ketikkan Google.com > Enter 

• Pada kotak keyword masukkan: define:information technology 

• Hasil pencarian akan terlihat seperti gambar dibawah ini. 

 
Gambar 3. Hasil pencarian menggunakan Define: 

3. AND dan OR 

Secara default Google menggunakan keyword AND yang menghubungkan antara kata 

satu dengan kata lainnya. Maka keyword: global warming sebenarnya sama dengan keyword : 

‘global’ AND ‘warming’. Sedangkan kata hubung OR akan digunakan untuk menemukan 

halaman yang setidaknya berisi dari salah satu dari keyword yang dimasukkan.  

Format untuk OR: 

Keyword OR keyword 

Lakukanlah contoh pencarian informasi seperti dibawah ini: 

• Buka program Google Chrome 

• Ketikkan Google.com > Enter 

• Pada kotak keyword masukkan: tempat makan di Jakarta OR Bandung 

• Hasil pencarian akan terlihat seperti gambar dibawah ini. 
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Gambar 4. Hasil pencarian menggunakan OR 

4. Karakter untuk menyaring kandungan kata yang dicari / Exclude (-) 

Apabila anda ingin mencari informasi tertentu dengan mengecualikan suatu kata yang 

tidak ingin ditampilkan, maka bisa digunakan tanda minus "-". Tanda minus tersebut untuk 

mengecualikan kata tertentu dalam pencarian.  

Lakukanlah contoh pencarian file seperti dibawah ini: 

• Buka program Google Chrome 

• Ketikkan Google.com > Enter 

• Contoh, masukkan keyword: green peace, lanjutkan tekan Enter 

o Perhatikan hasil pencariannya. 

o Maka terlalu banyak hasil yang ditampilkan yaitu greenpeace (tanpa spasi) 

 
Gambar 5. Pencarian tanpa tanda minus 
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• Kemudian cobalah memasukkan keyword: green peace –greenpeace, lanjutkan tekan 

Enter. 

o Perhatikan hasil pencariannya. 

o Dengan menggunakan tanda minus (-), menghasilkan kata greenpeace dikeluarkan 

didalam tampilan hasil pencarian. 

 
Gambar 6. Pencarian dengan tanda minus 

5. Mencari informasi sesuai dengan keyword di website tertentu secara spesific (site:) 

Google memungkinkan kita mencari sebuah informasi yang sesuai dengan keyword yang 

kita masukkan dengan pencarian ditujukan pada website tertentu secara spesifik. Formatnya: 

 

Keyword site:nama_domain 

 

Lakukanlah contoh pencarian informasi seperti dibawah ini: 

• Buka program Google Chrome 

• Ketikkan Google.com > Enter 

• Pada kotak keyword masukkan: universitas site:www.detik.com 

• Kemudian cobalah lagi dengan memasukkan keyword: universitas site:detik.com 

• Hasil pencarian akan terlihat seperti gambar dibawah ini. 



Trisakti School of Management  

Data Modeling and Visualization Laboratory/P24.25 

Hanya untuk digunakan di lingkungan TSM!  Page 15 of 178 

s 

Gambar 7. hasil pencarian dengan site: dengan memasukkan www. 

 
Gambar 8. hasil pencarian dengan site: tanpa www. 

 

Diskusikan dengan Instruktur dikelas apa yang membedakan hasil pencarian dengan 

memasukkan dua keyword yang berbeda diatas! 
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6. Mencari dokumen dengan format file tertentu (filetype:) 

Ada kalanya kita membutuhkan suatu artikel, informasi, data, ataupun jurnal yang 

termuat didalam sebuah file agar lebih mudah dalam merujuk penulisnya. Hal tersebut bisa 

dilakukan pencarian dengan menyertakan perintah jenis file. formatnya:  

 

Keyword filetype:ekstensi_file  

atau dibalik menjadi  

filetype:ekstensi_file keyword 

 

Lakukanlah contoh pencarian file seperti dibawah ini: 

• Buka program Google Chrome 

• Ketikkan Google.com > Enter 

• Pada kotak keyword masukkan: PSAK filetype:pdf. 

• Hasil pencarian akan terlihat seperti gambar dibawah ini. 

 
Gambar 9. Hasil pencarian dengan prioritas pada jenis file tertentu 

• Ekstensi file yang didukung dalam pencarian di google ini antara lain adalah : 

o Adobe Portable Document Format (pdf)  

o Adobe PostScript (ps)  

o Lotus 1-2-3 (wk1, wk2, wk3, wk4, wk5, wki, wks, wku)  

o Lotus WordPro (lwp)  
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o MacWrite (mw)  

o Microsoft Excel (xls) dan (xlsx) 

o Microsoft PowerPoint (ppt) dan (pptx) 

o Microsoft Word (doc) dan (docx) 

o Microsoft Works (wks, wps, wdb)  

o Microsoft Write (wri)  

o Rich Text Format (rtf)  

o Shockwave Flash (swf)  

o Text (ans, txt) 

7. Pencarian yang berhubungan dengan sebuah website tertentu (related:) 

Kita dapat mencari website yang berhubungan dengan nama website yang kita masukkan 

pada keyword. Formatnya: 

Related: nama_website 

Contoh penggunaan: 

• Buka program Google Chrome 

• Ketikkan Google.com > Enter 

• Pada kotak keyword masukkan: related:www.cnn.com 

• Hasil pencarian akan terlihat seperti gambar dibawah ini. 

 
Gambar 10. Hasil pencarian dengan kode keyword related: 
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8. Mencari alamat URL yang mengandung kata tertentu (inurl:) 

Pada umumnya kita mencari berdasarkan isi dari sebuah halaman website, di Google 

memungkinkan kita mencari alamat URL dengan kata sesuai dengan yang kita masukkan. 

Formatnya: 

 

Inurl: keyword atau nama_domain 

 

Contoh penggunaan inurl: pada pencarian informasi seperti dibawah ini: 

• Buka program Google Chrome 

• Ketikkan Google.com > Enter 

• Pada kotak keyword masukkan: inurl:indonesia (indonesia sebagai kata) 

• Kemudian lakukan sekali lagi dengan memasukkan keyword: inurl:indonesia.go.id 

(indonesia sebagai nama domain) 

• Hasil pencarian akan terlihat seperti gambar dibawah ini. 

 

 
Gambar 11. hasil pencarian dengan inurl: tanpa level domain 

 

Top Level Domain (TLD): contoh; .com, .net, .org, .biz, .mil, dst... 

Sub Level Domain (SLD): contoh; .co.id, .net.id, .ac.id, .or.id, .co.au, .com.my, dst... 
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Gambar 12. hasil pencarian dengan inurl: dengan level domain 

9. Mencari halaman website dengan judul halaman tertentu (intitle:) 

Kode keyword intitle: digunakan untuk mencari kata tertentu yang terdapat pada judul 

dari halaman website. 

Setiap halaman website selalu diberikan judul oleh si pembuatnya. Apabila si pembuat 

website tidak memberikan judul pada halaman websitenya, maka secara default browser akan 

memberikan judul sama dengan nama domain website tersebut. Formatnya: 

intitle:keyword 
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Gambar 13. Letak nama judul halaman website 

 

Contoh penggunaan intitle: pada pencarian informasi seperti dibawah ini: 

• Buka program Google Chrome 

• Ketikkan Google.com > Enter 

• Pada kotak keyword masukkan: intitle:annual reports 

• Hasil pencarian akan terlihat seperti gambar berikut ini. 

Nama judul halaman website 
 

Judul halaman memungkinkan 
berbeda dengan nama domain 

website tersebut. 
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Gambar 14. Hasil pencarian dengan target judul halaman yang sesuai dengan keyword 

 
Gambar 15. Judul halaman website yang sesuai dengan keyword 

Nama judul halaman website 
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10.  Pencarian link yang merujuk ke website tertentu (link:) 

Kode keyword link: bisa digunakan untuk mengetahui seberapa banyak website yang 

terhubung ke suatu website, atau untuk mengetahui website mana saja yang menuliskan link 

ke suatu website tertentu. Formatnya: 

Link:nama_domain 

 

Contoh penggunaan link: pada pencarian informasi seperti dibawah ini: 

• Buka program Google Chrome 

• Ketikkan Google.com > Enter 

• Pada kotak keyword masukkan: link:indonesia.go.id 

• Hasil pencarian akan terlihat seperti gambar dibawah ini. 

 
Gambar 16. Hasil pencarian  halaman website yang membuat link ke website 

tertentu sesuai keyword 

 

11.  Melihat info tentang suatu website (info:) 

Fungsi ini untuk menampilkan informasi dari Google mengenai website yang dicari. 

Maksudnya seperti pokok-pokok bahasa apa saja yang disajikan dalam sebuah situs tersebut 

dan dikemas dalam halaman website. Formatnya: 

Info:nama_domain 

Contoh penggunaan info: pada pencarian informasi seperti dibawah ini: 

• Buka program Google Chrome 

• Ketikkan Google.com > Enter 
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• Pada kotak keyword masukkan: info:www.indonesia.go.id 

• Hasil pencarian akan terlihat seperti gambar dibawah ini. 

 
Gambar 17. Hasil pencarian dengan info: 

 

B. MEMBUAT AKUN GMAIL (GOOGLE MAIL) 

Google memberikan layanan berupa akun untuk bisa masuk lebih jauh dalam 

memanfaatkan fitur-fitur Google. Selain berfungsi sebagai e-mail, maka Gmail juga mampu 

berfungsi sebagai akun login dalam memanfaatkan fitur-fitur Google lainnya  seperti untuk 

bicara (Google Talk) , ngobrol, berbagi, pembuatan jadwal, penyimpanan, pengaturan, 

berkolaborasi, menemukan, dan pembuatan. Dengan menggunakan Gmail maka anda bisa 

menggunakan produk Google mulai dari Gmail, Google+, hingga YouTube, foto, download 

aplikasi games dan software untuk sistem operasi Android, melihat riwayat penelusuran Anda, 

bahkan hingga pembelian barang dengan ponsel yang menggunakan Google Wallet, semua itu 

dengan satu nama pengguna dan sandi (SSO: Single Sign On / Single Login). 

Berikut langkah-langkah dalam membuat akun Google: 

1. Buka program Google Chrome dengan  ikon Google Chrome di toolbar Windows. 

2. Kemudian ketikkan www.gmail.com atau langsung gmail.com (tanpa mengetik www.) 

lanjutkan dengan menekan tombol ENTER pada keyboard. 

3. Maka akan tampil halaman depan website Gmail seperti pada gambar dibawah ini: 
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Gambar 18. Tampilan halaman depan Gmail.com 

4. Dibagian kanan atas, terdapat tombol , maka  tombol tersebut untuk 

membuat akun Gmail. 

5. Pada tampilan berikutnya, isilah dengan lengkap seperti: 

a. Nama (nama depan dan belakang), nama username (akan digunakan sebagai nama 

akun/nama e-mail), masukkan password, masukkan tanggal lahir dan jenis kelamin. 

b. Kemudian, masukkan nomor handphone. Nomor handphone ini akan digunakan untuk 

melakukan konfirmasi registrasi, reset passsword jika lupa dan lainnya. oleh karena itu 

masukkan nomor handphone dengan benar sesuai dengan nomor handphone yang anda 

miliki. 

c. Masukkan kode verifikasi sesuai dengan yang tertera. Hal ini dibutuhkan untuk 

memastikan bahwa pembuatan akun yang sedang dilakukan adalah dilakukan oleh 

pengguna langsung, bukan oleh generate program software dengan maksud tertentu 

(maksud jahat: booming). 

d. Centang (check) “I Agree to the Google Terms of Service and Privacy Policy”. Hal 

ini dilakukan untuk memastikan bahwa anda menyetujui dan menyanggupi aturan-

aturan umum yang berlaku di Google. 

6. Berikut contoh hasil pengisian pendaftaran Gmail: 
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7. Setelah memastikan data-data terisi lengkap, maka lanjutkan dengan  tombol “Next step” 

8. Apabila pengisian data-data sudah benar dan nama akun tidak duplikasi (belum ada yang 

memiliki) maka anda akan masuk ke halaman Profile 
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Gambar 19. Halaman Profile di Google Account 

C. TUGAS 

1. Mencoba fitur-fitur dari Search  Engine Google di Rumah! 

2. Perhatikan apa perbedaan kode keyword: universitas site:kompas dengan universitas 

site:www.kompas ?! 

3. Mana yang lebih luas hasil pencarian dari keyword indonesia inurl:kompas dengan 

indonesia site:kompas ? 

4. Apa saja manfaat memiliki akun Gmail? 
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BAB II  CLOUD COMPUTING: GOOGLE APPS 
  

 

Topik Utama 

✓ Mahasiswa memahami apa itu Cloud Computing? 

✓ Mahasiswa mengetahui jenis-jenis layanan Cloud Computing 

✓ Mahasiswa mengetahui manfaat-manfaat dan kelemahan Cloud 

Computing 

✓ Mahasiswa mengetahui beberapa tempat layanan Cloud 

Computing 

✓ Mahasiswa mengetahui layanan Google Apps (Google 

Applications) 

✓ Mahasiswa mencoba beberapa fitur dari Google Drive 

✓ Mahasiswa mencoba beberapa fitur dari Google Form 

 

 

Hubungan dengan Bab lainnya 

✓ Bab II membuat akun Gmail (Google Mail) 

 

 

Pertanyaan Umum 

✓ Apakah Cloud Computing merupakan kebutuhan atau hype di 

era saat ini? 

✓ Apakah anda masih menyukai menggunakan aplikasi offline 

atau sudah membutuhkan aplikasi online? 

✓ Manfaat langsung apa saja yang anda rasakan dengan 

menggunakan Google Apps? 

 

Praktikum  Signin ke Google Apps 

 Membuat folder 

 Membuat Formulir dengan Google Forms 
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A. PENGENALAN CLOUD COMPUTING 

1. Pengertian Cloud Computing 

 

Cloud Computing menurut National Institute of Standards and Technology’s (NIST, 

2009), adalah suatu model penyediaan sumberdaya komputasi (misalnya; jaringan, server, 

penyimpanan, aplikasi, dan jasa) yang dikonfigurasi agar bisa dengan mudah dan nyaman 

diakses melalui jaringan dan memungkinkan manajemen dapat "menyewa dan menggunakan" 

layanan dengan cepat, dimana penetapan kebutuhan disesuaikan oleh penyewa, dengan upaya 

dan kebutuhan akan interaksi dengan penyedia layanan yang minimal. 

Melalui pengertian secara sederhana dikatakan bahwa cloud computing merupakan suatu 

teknologi komputasi yang dibangun oleh penyedia layanan (biasanya oleh IT company) 

kemudian penyedia layanan cloud computing tersebut menyewakan kepada perusahaan-

perusahaan/individual dengan layanan yang disewa (misalnya; jaringan, server, penyimpanan, 

aplikasi, dan jasa) sesuai kebutuhan pengguna dan ditetapkan dalam SLA (Service Level 

Agreement) antara penyedia layanan dengan perusahaan penyewa. 

Teknologi cloud computing terbentuk dan tumbuh akibat maraknya perusahaan yang 

membutuhkan infrastruktur jaringan, server, penyimpanan, dan aplikasi yang semakin 

meningkat. Perusahaan-perusahaan sudah semakin banyak menyadari pentingnya teknologi 

informasi didalam membangun dan mendukung strategi bisnisnya. Namun, biaya untuk 

memiliki dan memelihara teknologi informasi tidaklah murah, selain itu konsumen yang 

semakin pintar dengan berpikir bahwa, tidak semua teknologi yang sudah dibeli bisa dan perlu 

digunakan didalam bisnisnya. Analogi yang menyebutkan bahwa: “Untuk meminum susu sapi 

segar setiap hari, maka kita tidak perlu memelihara sapi, namun kita hanya perlu membeli 

sebotol susu segar sapi.” Analogi lainnya menyebutkan bahwa: “Untuk tinggal di rumah yang 

nyaman dan mempunyai banyak fasilitas seperti kolam renang, parkir dan taman yang luas, 

serta akses dan lokasi di pusat kota, maka kita hanya perlu menyewa sebuah ruang di 

apartemen. Kita tidak perlu untuk membeli rumah dan halaman yang besar di pusat kota yang 

mahal.” Pemikiran seperti inilah yang bisa diterapkan bagi perusahaan-perusahaan yang 

memerlukan teknologi informasi yang kuat, lengkap yang sesuai kebutuhan, namun tidak perlu 

membangun dan melakukan pemeliharaan yang rumit untuk memiliki hal tersebut cukup 

membayar kepada perusahaan yang menyediakan layanan tersebut sesuai apa yang kita 

gunakan. 

 

2. Jenis-jenis Layanan Cloud Computing 

 

Cloud Computing dibagi menjadi tiga layanan yaitu: 

1. Software as a Service (SaaS) 

Pengertian singkatnya, bahwa layanan ini merupakan layanan yang disediakan penyedia 

kepada pengguna berupa aplikasi-aplikasi (software) siap pakai. Dimana aplikasi-aplikasi 

tersebut bisa diakses via browser internet dengan menggunakan suatu akun yang 

disediakan si penyedia. 

2. Platform as a Service (PaaS) 
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PaaS adalah layanan yang disediakan untuk konsumen yang perlu mengembangkan 

aplikasinya namun hanya bisa berjalan diatas platform tertentu. 

Pionir PaaS ini adalah Google AppEngine, yang menyediakan berbagai perangkat untuk 

mengembangkan aplikasi diatas platform Google, dimana platform yang disediakan 

menggunakan bahasa pemrograman Phyton dan Django. 

3. Infrastructure as a Service (IaaS) 

Layanan yang diberikan kepada konsumen adalah memberikan kewenangan lebih dalam 

hal pengolahan, penyimpanan, jaringan dan sumberdaya komputasi mendasar lainnya, 

termasuk sistem operasi dan aplikasi yang bisa dikelola oleh konsumen. Namun, 

konsumen tetap tidak mengelola atau mengendalikan infrastruktur, seperti mesin apa, 

bagaimana, dan dimana mesin tersebut berada. Sekilas layanan ini mirip dengan layanan 

data center co-location, dimana konsumen menempatkan mesinnya di data center. 

 

Layanan-layanan tersebut beberapa bisa kita temukan secara gratis. Begitu juga dengan 

layanan dari Google seperti Google Drive (IaaS) dan Google Docs: Google Document, Google 

Spreadsheet, Google Presentation, Google Form, Google Drawing (SaaS). Berikut layanan-

layanan tidak berbayar dari Google Drive dan Google Apps. 

 

3. Google Drive 

 

Google Drive adalah bagian dari layanan yang tersedia di Google Apps yang berfungsi 

sebagai tempat penyimpanan file di internet (di server Google). Google Drive ada yang 

berbayar dan ada yang gratis. Perbedaannya yang berbayar dan gratis terutama adalah kapasitas 

penyimpanan yang disediakan oleh masing-masing paket layanan. Hingga saat ini, Google 

Drive yang gratis memiliki daya tampung 15 GB (biasanya akan terus bertambah sejalan 

dengan waktu). 

 

Mengenal fitur-fitur dasar Google Drive. 

1. Pastikan anda telah memiliki akun Google (Gmail) 

2. Buka program Google Chrome  

3. Ketikkan drive.google.com (tanpa mengetik www.) pada URL address bar lanjutkan 

dengan menekan tombol ENTER pada keyboard. 

4. Maka akan tampil halaman web seperti pada gambar dibawah ini: 
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Gambar 20. Halaman login Google Drive 

5. Pada kotak Sign in:  

• Masukkan E-mail, gunakan akun gmail anda, 

•  Next 

• Masukkan Password, 

• Klik tombol Sign in. 

 
Gambar 21. Kotak login Google Drive 
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6. Setelah anda berhasil melakukan login, maka anda akan berada di halaman utama dari 

Google Drive, berikut bagian-bagian fitur yang terlihat di halaman utama Google Drive: 

 

 

 

 
Gambar 22. Halaman utama Google Drive dan fitur-fiturnya 

• 1: Inisial nama pemilik akun Gmail 

• 2: Notifications, pemberitahuan bahwa terdapat 3 pesan baru yang diterima. 

• 3: Setting, pengaturan untuk Bahasa, penyimpanan, pengaturan tampilan, dan 

sebagainya 

• 4: Details, memberikan informasi file yang ada di dalam Drive secara detail 

• 5: Sort Option, pengaturan daftar file 

• 6: Pengaturan tampilan pada Google Drive 

• 7: Kotak Pencarian 
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• 8: New, untuk membuat folder baru dalam drive dan untuk mengupload file yang baru, 

dan juga kita dapat membuat Google Docs, Google Sheets, Google Slides, Google 

Forms, Google Drawings, Google My Maps atau Connect more apps. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• 9: My Drive, Menampilan file yang tersimpan di Google Drive 

• 10: Shared with me, Menampilkan file yang dibagikan oleh orang lain 

• 11: Google Photos, Menampilakan file yang bertipe gambar 

• 12: Recent, Menampilkan file yang belum lama dilihat 

• 13: Starred, Menampilkan file yang kita tandai bintang 

• 14: Trash, Menampilkan file yang telah kita hapus 

• 15: Capacity, kapasitas penyimpanan dari Google Drive milik user 

• 16: Get Drive for PC, fitur ini memungkinkan Google Drive di sinkronisasi dengan 

harddisk PC user (PC Desktop, Notebook, dll). Untuk melakukan sinkronisasi Google 

Drive dengan PC memerlukan instalasi software yang harus dijalankan pada PC Anda. 

Membuat folder di google drive 

1. Bukalah halaman utama dari Google Drive 

2.  tombol  > pilih Folder  

3. Pada kotak dialog yang muncul: masukkan nama folder baru “Lab Aplikom” >  tombol 

Create 

 
  

Connect More Apps 
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4. Berikut hasil dari pembuatan folder baru tersebut: 

 
Gambar 23. Membuat folder baru di Google Drive 

4. Google Document 

 

Google document merupakan software pengolah kata online yang disediakan oleh 

Google secara gratis untuk membuat dokumen. Google document secara umum memiliki 

fungsi dan fitur seperti halnya Microsoft Word yang tersedia di Microsoft Office. 

 

 

Beberapa fitur unggulan dari Google document diantaranya: 

• Langsung terhubung dengan penyimpanan berbasis cloud computing, maka dari itu setiap 

perubahan akan otomatis tersimpan saat mengetik dan juga kita dapat menggunakan 

riwayat revisi untuk melihat versi lama dari dokumen yang sama. 

• Chat dan komentar dengan orang lain secara langsung di dalam dokumen atau tambahkan 

komentar dengan mengetik “+” alamat e-mail mereka dan mereka akan mendapatkan 

notifikasi. 

• Google document ini mempunyai fitur dimana rekan satu tim yang berada di tempat yang 

tidak sama dapat mengerjakan satu dokumen bersama-sama secara real time. 

• Google document pun kompetibel dengan Microsoft Word, sehingga file dari Google 

document dapat di konversi ke file Word dan sebaliknya. 

Berikut ini kita akan mencoba membuat sebuah document sederhana dari Google 

Document. 
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5. Google Presentation 

Google presentation merupakan software aplikasi online yang disediakan oleh Google 

secara gratis untuk membuat slide-slide presentasi. Google presentation secara umum memiliki 

fungsi dan fitur seperti halnya Microsoft PowerPoint yang tersedia di Microsoft Office. 

Beberapa fitur unggulan dari Google presentation diantaranya: 

• Presentasi menawarkan kemampuan dalam kolaborasi dalam pengerjaan disaat waktu yang 

sama (real time) diantara pemilik akun Google, dengan beberapa kewenangan seperti hanya 

melihat saja atau bisa melakukan perubahan terhadap file presentasi tersebut. 

• Chat dan komentar dengan orang lain secara langsung di dalam presentasi atau tambahkan 

komentar dengan mengetik “+” alamat e-mail mereka dan mereka akan mendapatkan 

notifikasi. 

• Anda bisa menyimpan file dalam format ZIP apabila anda ingin mengirimkan file tersebut 

sebagai attachment di e-mail anda. 

• Google presentation pun kompetibel dengan Microsoft PowerPoint, sehingga file dari 

Google document dapat di konversi ke file Word dan sebaliknya. 

 

6. Google Spreadsheet 

Google spreadsheet merupakan software pengolah angka dan kata online yang 

disediakan oleh Google secara gratis. Google spreadsheet secara umum memiliki fungsi dan 

fitur seperti halnya Microsoft Excel yang tersedia di Microsoft Office. 

Beberapa fitur unggulan dari Google spreadsheet diantaranya: 

• Langsung terhubung dengan penyimpanan berbasis cloud computing, maka dari itu setiap 

perubahan akan otomatis tersimpan saat mengetik dan juga kita dapat menggunakan 

riwayat revisi untuk melihat versi lama dari dokumen yang sama. 

• Chat dan komentar dengan orang lain secara langsung di dalam spreadsheet atau tambahkan 

komentar dengan mengetik “+” alamat e-mail mereka dan mereka akan mendapatkan 

notifikasi. 

• Google spreadsheet ini mempunyai fitur dimana rekan satu tim yang berada di tempat yang 

tidak sama dapat mengerjakan satu dokumen bersama-sama secara real time. 

• Google spreadsheet pun kompetibel dengan Microsoft Excel, sehingga file dari Google 

spreadsheet dapat di konversi ke file Excel dan sebaliknya. 

 

7. Google Forms 

 

Google form merupakan salah satu fasilitas pengolah data dari Google Apps secara 

gratis. Melalui aplikasi online ini, pengguna dimudahkan untuk membuat, mengumpulkan, dan 

menyusun informasi besar dan kecil dengan mudah. Google form atau yang disebut Google 

formulir adalah alat yang berguna untuk membantu Anda untuk merencanakan acara, mengirim 

survei, memberikan siswa atau orang lain kuis, atau mengumpulkan informasi yang mudah 

dengan cara yang efisien. 
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Beberapa fitur unggulan dari Google document diantaranya: 

• Dapatkan jawaban dengan cepat. 

• Tampilan form unik. 

• Formulir dibuat dengan mudah untuk dibuat, diedit, dan ditanggapi di layar besar maupun 

kecil 

• Tanggapan survei dikumpulkan dalam Formulir dengan rapid an secara otomatis, disertai 

info tanggapan waktu nyata dan grafik 

• Dapat disusun bersama-sama 

Berikut ini kita akan mencoba membuat sebuah formulir sederhana dari Google Forms. 

Membuat file Form baru 

1. Pastikan anda masih login di google drive 

2. Pada halaman utama Google Drive,  menu My Drive >  folder Lab Aplikom 

3.  tombol  > More > pilih  

4. Maka akan muncul sebuah window baru pada tab browser yang berisi Untitled form 

baru seperti gambar berikut: 

 

 
Fitur Google Forms: 

1. Title Form  6. Settings 

2. Questions, pertanyaan di dalam 

formulir 

 7. Send 

3. Responses, respon yang telah 

didapatkan 

 8. More 

 

4 

5 
6 7 8 

1 

2 

3 

9 

10 

11 
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4. Color Palette, mengganti warna form  9. Icon Bar, add question, add title and 

description, add image, add video and 

add section 

5. Preview  10. Form Description 

   11. Judul pertanyaan 

Pada latihan kali ini, kita akan mencoba membuat formulir sederhana. 

1. Membuat nama form 

•  pada “Untitled form” >  “Pengetahuan Anda tentang Tokopedia” 

•  pada “Form Description” >  “Bapak/Ibu/sdr/i yang saya hormati, perkenalkan 

nama saya ______. Saya meminta kesediaan waktu dan perhatian responden untuk 

mengisi kuesioner ini dengan lengkap. Adapun data mengenai responden beserta 

hasilnya akan dijaga kerahasiaannya”. 

 
2. Membuat pertanyaan 

•  pada “Untitled Question” >  “Nama” 

•   untuk mengganti jenis pertanyaan >  

> dan  yang artinya pertanyaan tersebut dibutuhkan 
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3. Membuat pertanyaan Multiple Choice 

•  ikon add question pada icon bar  

•  pada “Untitled Question” >  “Jenis Kelamin” 

• Tipe pertanyaan Multiple Choice  

•  pada Option 1  dan rename pilihan tersebut >  “Laki-laki” 

•  add option / menekan enter > rename option 2 >  “Perempuan” 

 

4. Membuat pertanyaan Checkboxes 

•  ikon add question pada icon bar  

•  pada “Untitled Question” >  “Darimana Anda Mengetahui Tokopedia” 

• Tipe pertanyaan Checkboxes  

•  pada Option 1  dan rename pilihan tersebut >  “Internet” >  

•  rename option 2 >  “Iklan di Televisi” > 

•  rename option 2 >  “Iklan di Koran” > 

•  rename option 2 >  “Teman” > 

•  rename option 2 >  “Keluarga” 

•  ADD “OTHER” untuk  dijelaskan oleh responden 
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5. Membuat pertanyaan dengan Skala 

•  ikon add question pada icon bar  

•  pada “Untitled Question” >  “Apakah Tokopedia mudah digunakan?” 

• Tipe pertanyaannya Linear scale  

• buat skala dari 1 sampai 6 

• berikan label untuk 1 >  “label (optional)”,  “Sangat tidak setuju” 

• berikan label untuk 6 >  “label (optional)”,  “Sangat setuju” 
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6. Membuat Pertanyaan dengan jenis jawaban yang panjang 

•  ikon add question pada icon bar  

•  pada “Untitled Question” >  “Saranmu untuk Tokopedia?” 

• Tipe pertanyaannya Paragraph  

 

7. Membuat Pertanyaan dengan menyisipkan gambar 

•  ikon add image pada icon bar  

• Maka akan muncul kotak dialog insert image >  Choose an image to upload > 

Pilih gambar yang ingin Anda masukkan 

•  Image Title >  “Tokopedia” 

8. Kita telah membuat sebuah kuesioner, sekarang kita ingin melihat bagaimana hasil dari 

kuesioner kita 

•  Preview  

 

B. LATIHAN, DISKUSI DAN PERTANYAAN 

 

A. LATIHAN 1 

Kembangkan hasil latihan anda dengan beberapa hal seperti: 

1. Bagi-lah (share) file-file dokumen anda dengan beberapa teman yang anda kenal dengan 

beberapa fitur seperti: E-mail (Gmail), Google +, facebook, atau twitter 

2. Silahkan anda coba menggunakan fitur: menu File > Download as… 
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BAB III  MS OUTLOOK 2016 
  

 

Topik Utama 

✓ Mahasiswa memahami fungsi aplikasi MS Outlook? 

✓ Mengenal bagian-bagian umum MS Outlook 2016 

✓ Meneruskan e-mail masuk ke e-mail lain 

✓ Menghubungkan e-mail dengan Outlook 

✓ Membuat e-mail yang baik dan benar sesuai dengan netiket 

yang berlaku 

✓ Membuat Signature di dalam menuliskan e-mail 

✓ Mengatur Autoreply di MS Outlook 

 

 

Hubungan dengan Bab lainnya 

✓ Bab II 

 

 

Pertanyaan Umum 

✓ Apa itu MS Outlook 2016? 

✓ Apakah dengan fitur-fitur dari MS Outlook 2016 sangat 

membantu dalam mengirim/menerima pesan? 

  

Praktikum  Membuka program 

 Mengatur e-mail (Gmail) dan MS Outlook untuk menghubungkan e-

mail (Gmail) dengan MS Outlook 

 Meneruskan e-mail masuk ke e-mail lain 

 Menuliskan e-mail yang baik dan benar sesuai dengan netiket yang 

berlaku  

 Membuat Signature di dalam penulisan e-mail 

 Mengatur Autoreply di MS Outlook 
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A. PENGENALAN DASAR MS OUTLOOK 

Microsoft Outlook 2016 adalah sebuah aplikasi pengelola informasi pribadi dari 

Microsoft, yang tersedia baik sebagai aplikasi terpisah serta bagian dari Microsoft Office 

Suite. Aplikasi ini biasanya digunakan untuk mengirim dan membaca e-mail. Meskipun sering 

digunakan terutama sebagai e-mail, program ini juga memiliki fitur calender, jadwal kerja, 

catatan dan jurnal. 

Kelebihan dari MS Outlook 2016: 

• Dapat membaca e-mail secara offline 

• Dapat mengirim e-mail dengan cepat 

• Dapat mem-backup e-mail di PC 

• Dapat melakukan penjadwalan 

• Dapat memblokir e-mail dengan specific  

B. PENGATURAN MS OUTLOOK 

 

Untuk memasukan e-mail kita (Email Server) ke dalam MS Outlook (Email Client) ada 

langkah-langkah yang harus diikuti, yaitu sebagai berikut: 

Pengaturan untuk Gmail (Email Server) 

• Buka program Google Chrome dengan  ikon Google Chrome di toolbar 

Windows. 

• Kemudian ketikkan www.gmail.com atau langsung gmail.com (tanpa mengetik 

www.) lanjutkan dengan menekan tombol ENTER pada keyboard. 

• Log-in dengan e-mail yang telah Anda buat atau Log-in dengan e-mail yang Anda 

ingin hubungkan dengan MS Outlook 

• Maka akan tampil halaman depan website Gmail seperti pada gambar berikut ini: 
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• Lalu   Settings, maka akan tampil tampilan seperti ini: 

 

• Lalu pilih  Forwading and POP/IMAP >   Add a forwarding address > maka 

akan muncul kotak dialog baru  >  alamat e-mail yang Anda ingin teruskan >  Next 

 

• Setelah itu  Enablel POP for all mail 

• Setelah itu  Save Changes 

Mengaktifkan Allow less secure Apps: 
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•  inisial nama akun Anda di halaman Gmail >  My Account  > 

lalu muncul Tab baru 

 

•  Connected apps & sites >  Tombol Allow less secure apps 

 
 

Info  

IMAP vs POP IMAP dan POP adalah dua cara untuk membaca pesan Email Server 

(Gmail) Anda di program email lain/Email Client (Microsoft Outlook) 

 ➢ Internet Message Access Protocol (IMAP) dapat digunakan di 

beberapa perangkat dan disinkronkan secara real-time. 
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➢ Post Office Protocol (POP) hanya dapat digunakan untuk satu 

komputer, tidak secara real-time, dan user yang memutuskan 

seberapa sering ingin mengunduh email baru. 

 

 

 

Pengaturan untuk MS Outlook 

•   Tab File >  Add Account > lalu akan muncul kotak dialog Add Account >  

Manual  setup or additional server types >  Next >  POP or IMAP >  Next 

>  text box sesuai dengan informasi e-mail yang akan Anda hubungkan >  

“pop.gmail.com” pada text box Incoming mail server >  “smtp.gmail.com” pada 

text box Outgoing mail server (SMTP) 
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Info  

IMAP vs POP3 Incoming mail server (POP3/IMAP): server yang mengatur untuk 

menerima email 

Outgoing mail server (SMTP/Simple Mail Transfer Protocol): server 

yang mengatur untuk email keluar 

 ➢ Internet Message Access Protocol (IMAP): dua arah, sinkronisasi 

data real-time. Tidak hanya mengunduh semua pesar dari email 

server, tetapi juga dapat memilih email yang ingin diunduh, 

membuat folder di server, mencari pesan email tertentu, atau 

menghapus email yang ada. 
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➢ Post Office Protocol version 3 (POP3): satu arah, mengunduh saja 

dari email server ke komputer. 

 

 

• Email Address dan User Name harus sama dan Password juga harus sesuai dengan 

password email server. 

•  More Settings … > maka muncul kotak dialog Internet E-mail Settings >  Tab 

Outgoing Server >  kotak (check) My outgoing server (SMTP) requires 

authentication >  Tab Advanced >  kotak  (check) This server requires an 

encrypted connection (SSL) pastikan angka yang ada pada Incoming server 

(POP3) ”995” > Ganti angka pada Outgoing server (SMTP) menjadi “587” > Ganti 

Use the following type of encrypted connection menjadi TLS >  OK 
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• Kembali ke kotak Add Account >  Next > lalu akan muncul kotak dialog baru Test 

Account Settings > tunggu kedua Status-nya Completed >  Close 

 

C. MEMBUKA PROGRAM MS OUTLOOK 

Berikut langkah-langkah untuk membuka program MS Outlook 2016: 

•  Start  > Microsoft Office Outlook 2016 
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Gambar 24. Tampilan awal MS Outlook 2016 

 
Setelah  program MS Outlook 2016, maka akan tampil window MS Word. Berikut 

bagian-bagian dari fitur MS Outlook 2016: 

 

1. Quick Access Toolbar 6. Mail 

2. Tab Ribbon 7. Calender 

3. Tab Menu 8. Navigation Option 

4 

7 

8 

5 

3 1 

6 

9 10 

2 
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4. Nama File yang sedang terbuka 9. Tombol View 

5. Folder Pane 10. Pengaturan Zoom 

 

D. PENGATURAN AUTO REPLY DI MS OUTLOOK 

Auto Reply adalah fitur dimana jika ada e-mail yang masuk ke dalam Inbox Anda, maka 

Auto Reply akan mengirimkan pesan balik sesuai dengan yang telah kita atur di MS Outlook. 

Berikut adalah pengaturan Auto Reply di MS Outlook: 

•  New E-mail > lalu ketikan e-mail seperti berikut 

 

• Setelah selesai  File di Ribbon > Save As > Browse this PC > save di folder 

masing-masing, dengan File Name “Auto Reply” dan Save as type “Outlook 

Templates” >  Save >  Close hingga kembali ke halaman MS Outlook 

 

•  Rules pada grup “Move” >  Manage Rules & Alerts… > maka akan muncul 

kotak dialog Rules and Alerts 
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•  New Rule > maka akan muncul kotak dialog yang baru Rules Wizard >  Apply 

rule on messages I receive >  Next >  kotak (checklist) di Sent only to me >  

Next >  kotak (checklist) Reply using a specific template >  a specific template 

di Step 2 > lalu pilih template yang telah dibuat sebelumnya di folder masing-masing 

>  Open >   Next >  Next > ganti nama untuk Rule tersebut menjadi “Auto 

Reply” >  Finish 
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E. MEMBUAT E-MAIL YANG BAIK DAN BENAR SESUAI DENGAN NETIKET 

YANG BERLAKU 

Seringkali kita tidak memperhatikan penulisan E-mail yang baik dan benar sesuai dengan 

netiket yang berlaku. Netiket itu sendiri adalah etika dalam  berkomunikasi melalui E-mail. 

Seperti halnya berkomunikasi melalui surat atau berkomunikasi secara langsung, 

berkomunikasi dengan e-mail pun mempunyai tata cara tersendiri.  

Netiket yang perlu diperhatikan, yaitu: 

1) Perlakukan e-mail secara pribadi 

2) Gunakan salam pembuka 

3) Gunakan kalimat dengan jelas dan singkat  

4) Jangan menggunakan huruf kapital 

5) Jangan menggunakan tanda baca yang berlebihan 

6) Jangan menggunakan Slang Words 

7) Perhatikan penggunaan warna dan jenis font 

8) Bacalah e-mail yang telah Anda buat sebelum mengirimkannya 

9) Ucapkan Terima kasih di akhir kalimat 

Berikut adalah langkah-langkah membuat E-mail di MS Outlook: 

• Pada Grup Menu NEW >   New Email  > maka akan muncul Windows 

yang baru 

 
• Setelah itu ketik alamat e-mail yang akan Anda kirimkan , Contoh: 

“Labkomputer.2016@gmail.com” 

• Setelah itu isikan Subject-nya. Subject merupakan judul dari e-mail yang Anda akan 

kirimkan, Contoh: “Perihal Tugas Praktikum ke-1” 
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• Selanjutnya ikutin gambar berikut 

 
• Setelah itu  Attach File >  Browse This PC… 

 
• Maka akan muncul kotak Insert File > pilih file yang ingin dikirimkan 

Dalam penulisan “Regards,   STIE TRISAKTI” kita menggunakan Signature 

• Pertama dropdown Signature >  Signature… > maka akan muncul kotak 

Signature and Stationery 
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•  New > maka muncul New Signature >  “Regards” >  OK 

 
• maka akan kembali ke Signature and Stationery > ketikan seperti gambar berikut: > 

 OK 

 
•  Send untuk mengirimkan e-mail tersebut 
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BAB IV  PREZI 
  

 

Topik Utama 

✓ Mahasiswa memahami fungsi aplikasi Prezi? 

✓ Mengenal bagian-bagian umum Prezi 

 

 

 

 

 

 

Hubungan dengan Bab lainnya 

 

 

 

 

 

Pertanyaan Umum 

✓ Apa yang perbedaan MS PowerPoint 2016 dengan Prezi? 

✓ Apakah dengan aplikasi Prezi membantu dalam pembuatan 

Presentasi yang lebih profesional? 

 

 

  

Praktikum  Membuat Account Prezi 

 Mengenalkan Tampilan Prezi 

 Mengenal cara-cara membuat presentasi 

 Mahasiswa mencoba membuat presentasi dengan aplikasi Prezi 
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A. PENGENALAN DASAR PREZI 

Prezi adalah salah satu software untuk presentasi yang berbasis internet (SaaS). Prezi 

juga dapat digunakan sebagai alat untuk mengeksplorasi dan berbagi ide di atas kanvas virtual. 

Prezi menggunakan Zooming User Interface (ZUI), hal inilah yang membuat Prezi mempunyai 

ciri khas dan keunggulannya sendiri, yang memungkinkan pengguna Prezi untuk memperbesar 

dan memperkecil tampilan media presntasinya. 

Prezi digunakan sebagai alat untuk membuat presentasi dalam bentuk linier maupun non-

linier. Presentasi linier adalah presentasi yang terstruktur artinya tampilan yang satu dengan 

yang lainnya saling berurutan, sedangkan presentasi non-linier adalah presentasi yang 

berbentuk mind-mapping. 

Keunggulan yang dimiliki oleh Prezi: 

• Tampilan Tema yang lebih bervariasi di bandingkan dengan Microsoft 

PowerPoint 

• Dalam mode presentasi Prezi lebih menarik, karena menggunakan teknologi ZUI 

• Lebih simple dalam hal pembuatan animasi 

• Pilihan tema dapat di unduh secara online 

Kelemahan yang dimiliki oleh Prezi: 

• Programnya berbayar 

• Program yang gratis membutuhkan internet 

• Sulit memasukan symbol matematika 

B. MEMBUAT AKUN PREZI 

Sebelum Anda membuat Presentasi dengan program Prezi Anda harus mempunyai Akun 

Prezi terlebih dahulu, karena Prezi Online maupun Prezi Desktop hanya dapat dibuka jika Anda 

memasukan akun tersebut. 

Ini adalah langkah-langkah dalam membuat akun Prezi: 

• Buka Google Chrome >  Google Chrome >  “prezi.com” pada URL Address Bar 
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• Lalu  Get Started 

 

•  Continue Free 
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• Lalu masukan Infomasi yang di butuhkan >  ”So What do you do?” lalu pilih “Student” 

>  “Select One” lalu pilih “Other” atau “Undergraduate Degree” 

 

•  Get Started 
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• Setelah itu Anda boleh Log out dan membuka program Prezi Desktop 

C. MEMBUAT PRESENTASI DENGAN PREZI 

Setelah membuka program Prezi Desktop, masukan Email dan Password Prezi yang telah 

Anda buat 
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Berikut adalah tampilan awal dari Prezi Desktop 

 
Gambar 25. Tampilan Prezi Desktop 
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Kita akan mencoba membuat sebuah Presentasi sederhana, ikuti langkah berikut: 

•  New Prezi > muncul kotak dialog Untitled Prezi  More 

 

•  “Timeline” di search for Templates >  Use Template 
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BAB V  MS WORD 2016 
  

 

Topik Utama 

✓ Mahasiswa memahami fitur-fitur dari MS Word 2016? 

✓ Mengenal bagian-bagian umum MS Word 2016 

✓ Menentukan format dokumen 

✓ Memanfaatkan ruler, header, dan footer 

✓ Mengolah teks dan tabel 

✓ Memahami pembuatan mail merge 

 

 

Hubungan dengan Bab lainnya 

✓ Bab VI MS Word – Lanjutan 

 

 

Pertanyaan Umum 

✓ Apa yang perbedaan mendasar dari fitur-fitur MS Word 2016 

dengan versi sebelumnya? 

✓ Apakah dengan fitur-fitur tambahan/baru dari MS Word 2016 

sangat membantu dalam pembuatan dokumen yang lebih 

profesional? 

  

Praktikum  Membuka program 

 Mengenal cara-cara lain menciptakan file dokumen 

 Menentukan format dokumen 

 Memanfaatkan fitur tabulator pada ruler 

 Mengolah header dan footer 

 Mengolah teks 

 Mengolah tabel 

 Membuat dan mengolah mail merge 

 Menyisipkan dan menampilkan field-field didalam mail merge 
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A. PENGENALAN DASAR MS WORD 2016 

 

Microsoft Office Word 2016 adalah program aplikasi lanjutan dari MS Word 2013 dan 

versi sebelumnya. Seperti halnya MS Word versi sebelumnya, MS Word 2016 tergabung 

didalam program aplikasi Microsoft Office 2016. Program ini banyak digunakan untuk 

berbagai pekerjaan aplikasi seperti pengolahan kata, seperti surat menyurat, membuat formulir, 

membuat naskah, membuat tabel, dan berbagai pengolahan kata lainnya. 

 

B. MEMBUKA PROGRAM MICROSOFT OFFICE WORD 2016 

 

Berikut langkah-langkah untuk membuka program MS Word 2016: 

•  Start  > Microsoft Office Word 2016 

•  Blank Document 

 
Gambar 26. Tampilan awal Microsoft Word 2016 

Setelah  program MS Word 2016, maka akan tampil window MS Word. Berikut 

bagian-bagian dari fitur MS Word 2016: 

1. Quick Access Toolbar 

2. Nama file dokumen 

3. Tombol pengatur Window 

4. Tab menu 

5. Dialog box 

6. Informasi dokumen 

7. Ruler 

8. Tombol view 

9. Zoom tool 
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Gambar 27. bagian-bagian umum dari window MS Word 2016 

C. MEMBUAT DAN MEMBUKA DOKUMEN 

 

Ada beberapa cara dalam membuat dan membuka dokumen. Berikut kita akan coba 

beberapa cara yang bisa kita lakukan. 

 

1. Membuat dan membuka dokumen dengan program MS Word 

 

Membuat dan membuka dokumen MS Word yang lazim biasanya dengan cara membuka 

terlebih dahulu program MS Word kemudian lakukan beberapa perintah pada program aplikasi 

tersebut. 

 

a. Save As 

•  Start > Microsoft Office Word 2016 

• Setelah tampil window MS Word 2016, lanjutkan dengan mengetik beberapa kalimat 

contoh didalam area kerja dokumen. Kemudian lakukan penyimpanan file seperti berikut: 

•  File > Save As 
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Gambar 28. menu Save MS Word 2016 

 

Kemudian: 

• Pada  Browse, maka akan muncul kotak dialog Save As tentukan direktori mana yang 

akan digunakan untuk menyimpan file dokumen yang baru saja dibuat diatas. 

o Diskusikan dengan Instruktur anda dikelas, dimana tempat penyimpanan file latihan 

anda harus disimpan. 

• Setelah menentukan direktori penyimpanan dokumen latihan, berikan nama file pada 

kotak File Name. Contoh berikan nama: “Contoh dokumen MS Word – 1” 

• Secara default, dokumen yang akan disimpan akan mempunyai ekstensi file .docx 

o Memberikan ekstensi file .docx memungkinkan bahwa file dokumen tersebut hanya 

akan bisa dibuka oleh MS Word 2016 

o Apabila kita menginginkan dokumen bisa dibuka oleh MS Word versi sebelumnya, 

kita bisa mengganti ekstensi file ke yang lain (lihat petunjuk Save As) 

• Setelah menentukan folder, nama file, dan type dokumen, kemudian  tombol Save. 
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Gambar 29. kotak dialog Save 

 
Gambar 30. Memilih format document 

 

b. Open 

Membuka dokumen yang sudah kita simpan secara lazim biasanya dengan menggunakan 

langkah-langkah berikut ini: 

• Tutuplah semua window program MS Word 2016 

•  Start > Microsoft Office Word 2016 

•  File> Open 
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•  Browse, maka akan tampil kotak dialog Open 

• Pilih folder tempat file dokumen latihan anda disimpan 

• Pilih salah satu dokumen yang ingin dibuka 

•  Open 
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c. Cara lain membuat dokumen MS Word baru 

Tidak seperti langkah-langkah lazim diatas yang biasa digunakan untuk membuat 

dokumen MS Word baru. Ada beberapa cara lain yang bisa digunakan untuk alternatif, 

diantaranya adalah dengan cara sebagai berikut: 

• Buka Windows Explorer dengan cara 

o R Start  > File Explorer, atau 

o + E, atau 

o  File Explorer  pada toolbar 

• Pada Windows Explorer, pilihlah folder tempat menyimpan file-file dokumen anda 

• Pada area sebelah kanan Windows Explorer lakukan: 

• R > New > Microsoft Office Word Document 

• Maka akan terbentuk sebuah file dokumen MS Word 

• Gantilah nama file dokumen yang sudah terbuat sesuai dengan nama “test.docx” 

 
Gambar 31. Membuat file dokumen pada Windows Explorer 

Klik kanan disini 

Pilih Folder latihan 
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Gambar 32. Mengganti nama file dokumen 

 

Tips  

Quick command • Ctrl+S : Save 

• Ctrl+O : Open 

• Ctrl+P : Print 

• Ctrl+N : New 

• Ctrl+A : Select All 

• Ctrl+C : Copy 

• Ctrl+X : Cut 

• Ctrl+V : Paste 

• Ctrl+Mouse scrolling button : Zoom-in atau Zoom-out 

• Ctrl+Delete      : Menghapus satu kata setelah kursor ditempatkan 

• Ctrl+Backspace  : Menghapus satu kata sebelum kursor ditempatkan 

D. FORMAT DOKUMEN 

 

Dalam membuat dokumen, hal pertama yang penting adalah menentukan format 

dokumen, yaitu menentukan dan mengatur format tampilan halaman demi halaman yang akan 

kita buat. 

1. Page Setup 

Melanjutkan praktikum sebelumnya, ikuti langkah-langkah berikut: 

• Bukalah dokumen dengan nama file: “Contoh dokumen MS Word - 1.docx” 

•  File > Save as 

• Buatkan nama file baru yaitu: “Latihan MS Word – NIM_Anda.docx” di folder yang 

sama 

• Apabila ada teks didalam halaman dokumen tersebut, hapus/kosongkanlah semuanya 

dengan cara Ctrl+A > Delete 

• Setelah halaman didalam dokumen tersebut bersih lanjutkan dengan memastikan: 

•  Tab menu: Layout > Page Setup: Margins > Normal 

•  Tab menu: Layout > Page Setup: Orientation > Potrait 

•  Tab menu: Layout > Page Setup: Size > A4 
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Gambar 33. Tab menu: Layout 

• Untuk mengatur sendiri tampilan halaman, anda bisa melihat dan merubahnya di: 

•  Tab menu: Layout > Page Setup >  Dialog Box  pada sudut kanan bawah di Page 

Setup 

• Maka akan tampil kotak dialog Page Setup seperti pada gambar dibawah ini: 

 
Gambar 34. Kotak dialog Page Setup 
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2. Mengenal bagian-bagian pada Ruler 

 

 

 

 
Gambar 35. Bagian-bagian dari fitur Ruler 

1. Ikon untuk mengubah simbol tab yang akan digunakan 

2. Left Margin: batas margin kiri dokumen 

3. Bar Tab: secara otomatis akan muncul garis vertikal pada dokumen 

4. Right Margin: batas margin kanan dokumen 

5. Hanging Indent: batas kiri teks yang ditulis 

6. First Line Indent: letak huruf pertama pada awal baris paragraf 

7. Top Margin: batas margin atas dokumen 

8. Left Tab: teks dengan format rata kiri 

9. Center Tab: teks dengan format rata tengah 

10. Right Tab: teks dengan format rata kanan 

11. Decimal Tab: bilangan desimal dengan tanda “,” (koma) akan diletakkan pada garis 

yang sama 

12. Right Indent: batas kanan teks yang ditulis 

 

Untuk berpindah dari tab satu ke tab lainnya gunakan tombol TAB pada keyboard. 

 

3. Membuat Header, Footer, dan nomor halaman 

 

Salah satu fitur umum dari MS Word adalah menyisipkan header dan footer pada setiap 

halamannya. 

a. Header 

Header adalah bagian dokumen yang terletak diatas setiap halaman, di bagian header ini 

kita bisa menuliskan sesuatu seperti: teks, tabel, gambar, nomor halaman, tanggal dan lainnya. 

Pada umumnya header ini akan tampil disetiap halaman. Maksudnya adalah apabila kita 

mempunyai 10 halaman dokumen, maka kita cukup merancang header satu kali saja akan tetapi 

rancangan header tersebut akan tampil sama di 10 halaman yang ada. 

Langkah-langkah untuk membuat header adalah: 

 

 

 

1 2 3 3 3 3 3 4 

5 

6 

8 9 10 11 12 

7 
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Mengaktifkan area header 

•  Tab menu: Insert > pada grup Header & Footer:  Header  

• Kemudian pilihlah Grid pada combo box yang muncul 

• Setelah secara otomatis header tampil didokumen, modifikasi dengan: 

o Pada kotak title didalam header:  “Belajar membuat dokumen pada MS Word 

2016” 

o Kemudian pada kotak date, pilihlah tanggal sekarang. 

 
Gambar 36. Memilih menu Header 

Menutup area header 

• Setelah selesai merancang header tutuplah header dengan cara: 

•  Tab menu: Design (Header & Footer Tools) > Close: Close Header & Footer 

 
 

 
Gambar 37. Contoh hasil menyisipkan header 

Klik ganda di area ini untuk menutup rancangan header 
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b. Footer 

Seperti halnya membuat header, membuat fungsi dari footer hampir sama dengan header 

hanya saja footer ditampilkan dibawah tiap halamannya. 

Contoh dalam membuat footer yaitu dengan langkah-langkah berikut ini: 

• Aktifkan dokumen latihan 

• Geser tampilan kebagian bawah halaman 

Mengaktifkan area footer 

•  Tab menu: Insert > pada grup Header & Footer:  Footer  

• Kemudian pilihlah Sideline pada combo box yang muncul 

• Setelah secara otomatis footer tampil didokumen 

 
Gambar 38. Contoh hasil menyisipkan footer 

Menutup area footer 

•  Tutuplah footer dengan cara: 

•  Tab menu: Design > Close: Close Header & Footer  

 

c. Membuat nomor halaman 

Dalam membuat nomor halaman selain secara otomatis dengan memilih template yang 

ada di header ataupun footer, kita bisa membuat nomor halaman dengan cara lain (customize). 

Contohnya adalah dengan langkah-langkah seperti dibawah ini: 

Mengaktifkan area header & footer 

• Aktifkan dokumen latihan 

• Kita akan mengganti footer yang sudah dibuat dengan menyisipkan nomor halaman 

• Geser tampilan dokumen kebagian bawah halaman hingga terlihat footer yang sudah kita 

rancang sebelumnya 

Menyisipkan nomor halaman 

•  Tab menu: Insert > pada grup Header & Footer:  Page Number 

• Sorot pointer ke Bottom of Page > cari dan pilih Bold Numbers 2 pada grup Pages X of 

Y didalam combo box 
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• Secara otomatis rancangan footer sebelumnya akan diganti menjadi rancangan nomor 

halaman yang baru 

 
Memilih menu Page Number 

•  Tab menu: Design > Close: Close Header & Footer  

 
Contoh hasil menyisipkan footer 

d. Menghapus header, footer atau nomor halaman 

Apabila kita tidak menginginkan adanya header, footer ataupun nomor halaman didalam 

dokumen kita maka kita bisa melakukan penghapusan dengan cara Remove Header/Footer. 

Langkahnya antaralain: 

• Untuk menghapus header: 

o Tab menu: Insert > Header & Footer: Header > Remove Header  

• Untuk menghapus footer: 

o Tab menu: Insert > Header & Footer: Footer > Remove Footer  
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• Untuk menghapus nomor halaman: 

o Tab menu: Insert > Header & Footer: Page Number > Remove Page Numbers 
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E. PRAKTIKUM MS WORD 2016 - 1 
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Ketentuan Soal Praktikum MS Word - 1:  

1. Paper size adalah Legal 

2. Margin atas 4 cm, bawah 2 cm, kiri 3 cm, kanan 3 cm 

3. Nama PT sampai dengan alamat email PT merupakan header dan setelah penandatanganan 

dokumen adalah footer 

4. Untuk nama PT menggunakan WordArt 

5. Gambar-gambar diatas dapat diganti dengan gambar lain 

6. Surat akan dikirimkan kepada: 

No Nama Kode Alamat 

1 Setsuna F. Seiei OO Sanjusangendo, Kyoto 

2 Amuro Ray UC Taito-ku, Tokyo 

3 Kira Yamato SD Toyonaka, Osaka 

4 Char Aznable UC Nakajimacho, Hiroshima 

5 Sei Iori BF Nagao, Tama-ku 

 

7. Ketentuan Discount diisi dengan menggunakan Rules: 

• Jika kode UC maka diskon 20% 

• Jika kode BF maka diskon 15% 

• Jika kode SD maka diskon 10% 

• Jika kode OO maka diskon 5% 

8. Untuk Harga (Net) diisi menggunakan Formula 
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F. PRAKTIKUM MS WORD 2016 - 2 
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Ketentuan Soal Praktikum MS Word – 2: 

1. Ukuran kertas A4 dengan margin Top, Bottom, Left, dan Right 2 cm 

2. Kop Surat adalah Header dan setelah nama Robin Anderson adalah Footer 

3. Fashion Flower menggunakan WordArt dan Footer menggunakan text Algerian 

4. Tulisan pada text menggunakan Times New Roman ukuran 12 dengan line spacing 1.15 

5. Tanda tangan Robin A menggunakan Font Type Vivaldi ukuran 22 

6. Watermark diagonal Fashion Flower 

7. Perhatikan text ada yang menggunakan Font Style seperti Strikethrough, Underline, Italic, 

dan Bold 

8. Surat akan dikirimkan kepada: 

Nomor Nama Alamat 
Tahu

n 
Kartu Member 

011/FF/8/201

9 

Aloha Jl. Cemara Blok A No.14-16 4 Silver 

012/FF/8/201

9 

Bejo Kav. RSU 78 Blok HH No.44 3 Bronze 

013/FF/8/201

9 

Ceria Green Boulevard No. 21 6 Gold 

014/FF/8/201

9 

Dilema Jl. Kenangan V No. 4 2 Bronze 

015/FF/8/201

9 

Endang Jl. Sanjaya Blok B-C No. 5-8 8 Platinum 

016/FF/8/201

9 
Firia 

Taman Surya 2 Blok CC No. 

45 
5 Silver 

017/FF/8/201

9 

Gilang Jl. Prof. Dr. Soetomo No. 4 7 Gold 

018/FF/8/201

9 

Handi Jl. Pengansaan Timur No. 6C 4 Silver 

019/FF/8/201

9 

Indi Jl. Penerimaan Blok D No. 15 8 Platinum 

020/FF/8/201

9 

Jelita Jl. Tawakal II No. 11-12 4 Silver 

 

9. Ketentuan Discount XXX diisi dengan menggunakan Rules. 

Kartu Member Discount Online purchase discount 

Platinum 5% 4% 

Gold 4% 3% 

Silver 3% 2% 

Bronze 2% 1% 

Catatan: Diskon di Table dalam Rupiah 

10. Pada table, selain kolom Regular Price, gunakan Formula 
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G. PRAKTIKUM MS WORD 2016 - 3 
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Ketentuan Soal Praktikum MS Word – 3: 

1. Paper Size A4, Margin Top & Bottom: 2,54 cm Left & Right: 1,91 cm. 

2. Tulisan “Your Life is on Your Decision” merupakan Footer. Font size untuk isi surat 12 

pt. 

3. Berikut data pemegang polis. 

4. Ketentuan potongan harga/discount 

a. Jika kurang dari 4 tahun mendapat diskon 1,5% 

b. Jika lebih dari sama dengan 4 tahun mendapat diskon 2% 

5. Iuran Khusus adalah harga setelah diskon. Sedangkan Iuran/tahun adalah harga setelah 

promo. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NO NAMA LOKASI 
PEMEGANG 

POLIS 

LAMA 

BERGABUNG 

007/GLARE/I/2019 Nia Fellycia Seoul Kesehatan 2 Tahun 

008/GLARE/I/2019 Mulia Kusuma New York Pendidikan 1 Tahun 

011/GLARE/I/2019 
Lussy 

Pebriyani 
Ottawa Property 3 Tahun 

019/GLARE/I/2019 Lavenia Arifin Sidney Jiwa 5 Tahun 

026/GLARE/I/2019 Rika Veronica Roma Jiwa 6 Tahun 

049/GLARE/I/2019 
Grace 

Veronica 
Abudabi Pendidikan 3 Tahun 

050/GLARE/I/2019 Sofi Aguswati London Kesehatan 4 Tahun 

078/GLARE/I/2019 Eva Eliana Macau Jiwa 2 Tahun 

089/GLARE/I/2019 David Bradley Paris Pendidikan 5 Tahun 

098/GLARE/I/2019 Fendi Setiady Tokyo Property 1 Tahun 
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H. PRAKTIKUM MS. Word 2016 - 4 
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Ketentuan Soal Praktikum MS Word – 4: 

1. Paper size adalah Legal 

2. Margin atas 3 cm, bawah 3 cm, kiri 3 cm, dan kanan 3 cm 

3. Nama Perusahaan sampai dengan Website Perusahaan merupakan header dan setelah 

penandatangan dokumen adalah footer. 

4. Nama Perusahaan menggunakan Wordart 

5. Ukuran font untuk isi surat adalah 11 

6. Surat akan dikirimkan kepada: 

 

7. Ketentuan Discount diisi dengan menggunakan Rules: 

➢ Jika Kategori Old maka mendapat diskon 10% 

➢ Jika Kategori Mid maka mendapat diskon 12% 

➢ Jika Kategori Young maka mendapat diskon 15% 

8. Ketentuan Special Gift diisi dengan menggunakan Rules: 

➢ Jika pembelian lebih dari sama dengan 100 maka mendapat hadiah Canvas 

Bag 

➢ Jika pembelian kurang dari sama dengan 100 maka mendapat hadiah Mangkuk 

Gula 

9. Semua perhitungan diisi dengan menggunakan Formula 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Nomor Nama Kategori Pembelian Kode 

AN/1 Angel Old 65 A/1 

GA/2 Gaby Mid 75 G/2 

ST/3 Steven Young 150 S/3 

EL/2 Elizabeth Old 100 E/4 

GR/5 Gracella Mid 50 G/5 
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BAB VI  MS WORD 2016 - LANJUTAN 
  

 

Topik Utama 

✓ Mahasiswa mampu mengolah dokumen dengan lebih praktis 

✓ Mampu membuat rancangan yang berbeda antara satu bagian 

dengan bagian lain didalam sebuah dokumen 

✓  Mengatur penomoran halaman di setiap section 

✓ Membuat otomatisasi pembuatan daftar isi, tabel maupun 

gambar 

 

 

Hubungan dengan Bab lainnya 

✓ Bab IV MS Word 2016 

 

 

Pertanyaan Umum 

✓ Apakah dengan menggunakan fitur Style pembuatan format 

teks anda menjadi lebih mudah? 

✓ Berapa file yang anda butuhkan dalam membuat sebuah 

dokumen yang lengkap termasuk didalamnya judul, daftar isi, 

daftar tabel, bab isi, dan referensi? 

✓ Bagaimana anda membuat tabel daftar isi sebelumnya? 

✓ Apakah penggunaan mail merge mempermudah pembuatan 

surat masal anda? 

  

Praktikum  Merancang tampilan halaman judul 

 Membuat dan menggunakan Style 

 Membuat dan membedakan rancangan setiap Section 

 Mengatur nomor halaman yang berbeda disetiap section 

 Membuat daftar isi, tabel dan gambar secara otomatis 
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A. PENGENALAN STYLE PADA MS WORD 2016 

Setiap pengguna komputer baik dunia profesional maupun pendidikan tentu akan 

dihadapkan pada pembuatan dokumen. Di dunia pendidikan contohnya ada mahasiswa dan 

dosen. Anda sebagai seorang mahasiswa sudah tentu akan banyak sekali mendapatkan tugas 

membuat paper, makalah, dan tentu saja tugas akhir (skripsi) pada semester akhir. Dalam 

membuat dokumen kadang harus terdiri dari judul, daftar isi, daftar tabel, bab-1, bab-2, dan 

seterusnya hingga ke bagian referensi, namun sering kita jumpai dalam membuat dokumen 

tersebut seseorang membuatnya dalam beberapa file. Seperti contoh: halaman judul satu file, 

daftar isi dan daftar lainnya satu file, bab-1 satu file, bab-2 satu file, dan seterusnya. Hal ini 

tentu saja menyulitkan dalam pemberian nomor halaman khususnya penentuan halaman pada 

daftar isi, daftar tabel, daftar gambar dan lainnya. 

Sebenarnya bagi pengguna komputer yang memakai MS Word, kita bisa memanfaatkan 

fitur yang disebut dengan Styles dan Section. Dengan mengatur dua fitur tersebut seorang 

penulis dibantu secara otomatis sehingga dengan mudah dapat membuat penomoran halaman, 

daftar isi dan daftar lainnya, pembedaan format tampilan setiap Section (bab 1 berbeda format 

tampilan dengan bab lainnya) hanya dalam satu file saja. 

Berikut didalam bab ini kita akan membahas Styles dan Section, serta fitur-fitur lainnya 

yang kita harapkan dapat membantu seorang penulis seperti layaknya seorang yang profesional 

membuat sebuah dokumen. Dengan memanfaatkan fitur-fitur tersebut kita akan mampu 

mempercantik dokumen, sehingga pembaca lebih tertarik untuk membacanya. 

Berikut dibawah ini gambar-gambar dokumen hasil dari pengaturan style dan section 

yang akan kita buat: 
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Gambar 39. Hasil dari pembuatan dokumen dengan Style dan Section 

 

B. MEMBUAT STYLE 

 

Didalam MS Office Word 2016, Quick Style adalah suatu kesatuan dari styles yang 

dirancang untuk bekerja bersama dalam menciptakan dokumen yang akan terlihat lebih atraktif 

dan profesional. Secara default Quick Style sudah disediakan dan siap digunakan, tapi dalam 

beberapa kasus terkadang kita ingin mengubahnya sesuai dengan selera kita sendiri. 

 

 
Gambar 40. Fitur Quick Style 
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Gambar 41. Style yang masih standar 

Berikut dibawah ini adalah contoh gambar dari hasil memodifikasi style yang akan kita 

lakukan pada latihan kali ini: 

 
Gambar 42. Hasil modifikasi Style 

Berikut kita akan memodifikasi style mulai dari judul bab, sub judul, hingga ke teks. 

Langkah-langkahnya antara lain: 

 

Membuat file dokumen baru 

• Buatlah sebuah dokumen baru di MS Word 2016 

•  Start  > Microsoft Office Word 2016 

• Simpan dokumen tersebut dengan nama: “Contoh dokumen MS Word - 3.docx” di folder 

atau direktori yang sama dengan dokumen latihan MS Word sebelumnya 
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Membuat teks 

• Letakkan kursor di dokumen yang kosong, kemudian tuliskan teks dibawah ini pada 

dokumen baru anda: 

 
Gambar 43. Membuat teks untuk Style 

Memilih Style 

•  di teks “Judul Bab” >  Tab menu: Home > grup Styles: pilih Heading 1 

•  di teks “Sub Judul Bab” >  Tab menu: Home > grup Styles: pilih Heading 2 

•  di teks “Sub-Sub Judul Bab” >  Tab menu: Home > grup Styles: pilih Heading 3 

•  di teks “Sub-Sub-Sub Judul Bab” >  Tab menu: Home > grup Styles: pilih Heading 

4 

•  di teks “Judul Paragraf” >  Tab menu: Home > grup Styles: pilih Title 

•  di teks “Sub Judul Paragraf” >  Tab menu: Home > grup Styles: pilih Subtitle 

•  di teks “Teks paragraf...” >  Tab menu: Home > grup Styles: pilih Normal 

• Hasil pemilihan Style standar akan terlihat seperti dibawah ini: 
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Gambar 44. Style yang masih standar MS Word 2016 

Memodifikasi Style Heading 1 

•  di teks “Judul Bab”  

•  Tab menu: Home > grup Styles: R Heading 1 >  Modify... 

 
Gambar 45. Pop-up menu pada Style 

• Maka akan muncul kotak dialog Modify Style, kemudian lakukanlah: 



Trisakti School of Management  

Data Modeling and Visualization Laboratory/P24.25 

Hanya untuk digunakan di lingkungan TSM!  Page 92 of 178 

 
Gambar 46. Pop-up menu Modify Style 

o   tombol Format ( ) >  Font... > maka akan muncul kotak dialog 

Font 

▪ Pada kotak dialog Font, aturlah >  Font: Arial Black, Size: 16, Font 

Color: White >  OK 

o   tombol Format ( ) >  Paragraph...> Kotak dialog Paragraph 

▪ Pada kotak dialog Paragraph >  Tab: Indents and Spacing > tentukan: 

• Alignment: Centered, Outline level: Level 1,  

• Left: 0 cm, Right: 0 cm, Special: (none), By: blank,  

• Before: 0 pt, After: 12 pt, Line spacing: Single, At: blank  

• Non aktifkan Don’t add space between pharagraphs of the same 

style >  OK 

o   tombol Format ( ) >  Border...> Kotak dialog Border and 

Shading 

▪ Pada kotak dialog Border and Shading >  Tab: Shadding >  Fill: 

Darker 50% (Gray) >  OK 

• Pada kotak dialog Modify Style >  OK 

Memodifikasi Style Heading 2 

•  di teks “Sub Judul Bab”  

•  Tab menu: Home > grup Styles: R Heading 2 >  Modify... 
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• Maka akan muncul kotak dialog Modify Style, kemudian lakukanlah: 

o   tombol Format ( ) >  Font... > maka akan muncul kotak dialog 

Font 

▪ Pada kotak dialog Font, aturlah >  Font: Century Gothic, Font Style: 

Bold, Size: 14, Font Color: Blue, Effects: Shadow >  OK 

o   tombol Format ( ) >  Numbering... > kotak dialog Numbering 

& Bullets 

▪ Pada kotak dialog Numbering & Bullets > pada grup Numbering:  A. 

B. C.  >  OK 

 
 

o   tombol Format ( ) >  Paragraph... 

▪ Pada kotak dialog Paragraph >  Tab: Indents and Spacing > tentukan: 

• Alignrment: Left, Left: 0 cm, Right: 0 cm, Special: Hanging, By: 

1 cm 

• Before: 12 pt, After: 6 pt, Line Spacing: Single, At: Blank,  

• non aktifkan Don’t add space between paragraphs of the same 

style >  OK 

Memodifikasi Style Heading 3 

•  di teks “Sub-Sub Judul Bab”  

•  Tab menu: Home > grup Styles: R Heading 3 >  Modify... 

• Maka akan muncul kotak dialog Modify Style, kemudian lakukanlah: 

o   tombol Format ( ) >  Font... > maka akan muncul kotak dialog 

Font 

▪ Pada kotak dialog Font, aturlah >  Font: Arial, Font Style: Bold, Size: 

12, Font Color: Blue >  OK 

o   tombol Format ( ) >  Numbering... > kotak dialog Numbering 

& Bullets 

▪ Pada kotak dialog Numbering & Bullets > pada grup Numbering:  1. 2. 

3. >  OK 
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o   tombol Format ( ) >  Paragraph... 

▪ Pada kotak dialog Paragraph >  Tab: Indents and Spacing > tentukan: 

• Alignrment: Left, Left: 0 cm, Right: 0 cm, Special: Hanging, By: 

1 cm 

• Before: 12 pt, After: 6 pt, Line Spacing: Single, At: Blank,  

• non aktifkan Don’t add space between paragraphs of the same 

style >  OK 

Memodifikasi Style Heading 4 

•  di teks “Sub-Sub-Sub Judul Bab”  

•  Tab menu: Home > grup Styles: R Heading 4 >  Modify... 

• Maka akan muncul kotak dialog Modify Style, kemudian lakukanlah: 

o   tombol Format ( ) >  Font... > maka akan muncul kotak dialog 

Font 

▪ Pada kotak dialog Font, aturlah >  Font: Century Gothic, Font Style: 

Bold Italic, Size: 12, Font Color: Blue >  OK 

o   tombol Format ( ) >  Numbering... > kotak dialog Numbering 

& Bullets 

▪ Pada kotak dialog Numbering & Bullets > pada grup Numbering:  a. b. 

c. ( ) >  OK 

o   tombol Format ( ) >  Paragraph... 

▪ Pada kotak dialog Paragraph >  Tab: Indents and Spacing > tentukan: 
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• Alignrment: Left, Left: 0 cm, Right: 0 cm, Special: Hanging, By: 

1 cm 

• Before: 12 pt, After: 6 pt, Line Spacing: Single, At: Blank,  

• non aktifkan Don’t add space between paragraphs of the same 

style >  OK 

Memodifikasi Style Title 

•  di teks “Judul Paragraf”  

•  Tab menu: Home > grup Styles: R Title >  Modify... 

• Maka akan muncul kotak dialog Modify Style, kemudian lakukanlah: 

o   tombol Format ( ) >  Font... > maka akan muncul kotak dialog 

Font 

▪ Pada kotak dialog Font, aturlah >  Font: Cambria, Font Style: Bold, 

Size: 14, Font Color: Orange >  OK 

o   tombol Format ( ) >  Border... 

▪ Pada kotak dialog Borders and Shanding >  Tab: Borders > tentukan: 

1. Style: Pilih Single line ( ) 

2. Color: Orange 

3. Width: 1 pt 

4. Aktifkan tombol bottom border ( ) 

5.  OK 

 

o   tombol Format ( ) >  Paragraph... 

▪ Pada kotak dialog Paragraph >  Tab: Indents and Spacing > tentukan: 

• Alignrment: Left, Outline level: Body Text 

• Left: 0,5 cm, Right: 0 cm, Special: (None), By: blank 

• Before: 12 pt, After: 6 pt, Line Spacing: Single, At: Blank,  

• non aktifkan Don’t add space between paragraphs of the same 

style >  OK 



Trisakti School of Management  

Data Modeling and Visualization Laboratory/P24.25 

Hanya untuk digunakan di lingkungan TSM!  Page 96 of 178 

Memodifikasi Style Sub Title 

•  di teks “Sub Judul Paragraf”  

•  Tab menu: Home > grup Styles: R Sub Title >  Modify... 

• Maka akan muncul kotak dialog Modify Style, kemudian lakukanlah: 

o   tombol Format ( ) >  Font... > maka akan muncul kotak dialog 

Font 

▪ Pada kotak dialog Font, aturlah >  Font: Cambria, Font Style: Bold 

Italic, Size: 12, Font Color: Orange >  OK 

o   tombol Format ( ) >  Paragraph... 

▪ Pada kotak dialog Paragraph >  Tab: Indents and Spacing > tentukan: 

• Alignrment: Left, Outline level: Body Text 

• Left: 0,5 cm, Right: 0 cm, Special: (None), By: blank 

• Before: 12 pt, After: 6 pt, Line Spacing: Single, At: Blank,  

• non aktifkan Don’t add space between paragraphs of the same 

style >  OK 

Memodifikasi Style Normal 

•  di teks “Teks Paragraf...”  

•  Tab menu: Home > grup Styles: R Normal >  Modify... 

• Maka akan muncul kotak dialog Modify Style, kemudian lakukanlah: 

o   tombol Format ( ) >  Font... > maka akan muncul kotak dialog 

Font 

▪ Pada kotak dialog Font, aturlah >  Font: Calibri (Body), Font Style: 

Regular, Size: 11, Font Color: Automatic >  OK 

o   tombol Format ( ) >  Paragraph... 

▪ Pada kotak dialog Paragraph >  Tab: Indents and Spacing > tentukan: 

• Alignrment: Justified, Outline level: Body Text 

• Left: 0,5 cm, Right: 0 cm, Special: First line, By: 1,5 

• Before: 0 pt, After: 6 pt, Line Spacing: 1,5 lines, At: Blank,  

• non aktifkan Don’t add space between paragraphs of the same 

style >  OK 

 

C. MEMBUAT SECTION 

 

Setelah membuat style, kita bisa melanjutkan dengan menentukan section untuk 

keperluan pembuatan dokumen. Dengan penggunaan dan pembagian section, kita 

memungkinkan merancang header dan footer yang berbeda-beda antara satu section dengan 

section lainnya. Berikut dibawah ini adalah contoh gambar hasil dari penataan section: 

 

Menyimpan file dokumen sebagai dokumen baru 
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• Melanjutkan latihan sebelumnya, aktifkan window dokumen “Contoh dokumen MS 

Word - 3.docx” yang masih terbuka 

•  File >  Save as > Browse, maka akan keluar kotak dialog Save As 

• Pada kotak dialog Save As > Simpan dokumen dengan : 

o File Name: “Contoh dokumen MS Word - 4.docx”  

o Save as type: Word document (*.docx) 

o Pastikan folder atau direktori yang sama dengan dokumen latihan MS Word 

sebelumnya 

Bersihkan teks sebelumnya 

• Tekan tombol CTRL+A pada keybord > lanjutkan dengan tekan DELETE untuk 

menghapus semua teks yang ada sebelumnya. 

Membuat teks 

• Letakkan kursor di dokumen yang kosong, kemudian tulislah teks dibawah ini pada 

dokumen baru anda tersebut: 

 

Judul 

Daftar Isi 

Daftar Gambar, Bagan, dan Tabel 

BAB I. PENDAHULUAN 

Pengenalan e-Business dan e-Commerce 

Dasar-dasar e-Commerce 

Infrastruktur e-Business 

e-Environment 

BAB II. STRATEGI DAN PENERAPAN 

Strategi e-Business 

Supply Chain Management 

e-Procurement  

e-Marketing 

Customer Relationship Management 

BAB III. IMPLEMENTASI 

Manejemen Perubahan 

Analisis dan disain 

Implementasi dan pemeliharaan 

REFERENSI 

 

• Setelah selesai menuliskan teks diatas, hal tersebut dilakukan sebagai acuan struktur 

dokumen/buku yang akan dibuat, lanjutkan dengan memberikan Style pada setiap baris 

teks diatas. 

• Berikut langkah-langkahnya: 

Menentukan Style: 

•  teks “Daftar Isi” >  tab menu: Home > grup Styles:  Heading 1 

Section untuk Daftar Isi 

Section untuk Daftar Gambar 

Section untuk Bab 1 

Section untuk Bab 2 

Section untuk Bab 3 

Section untuk Referensi 
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•  teks “Daftar Gambar, Bagan, dan Tabel” >  tab menu: Home > grup Styles:  

Heading 1 

•  teks “BAB I. PENDAHULUAN” >  tab menu: Home > grup Styles:  Heading 1 

•  teks “BAB II. STRATEGI DAN PENERAPAN” >  tab menu: Home > grup Styles: 

 Heading 1 

•  teks “BAB III. IMPLEMENTASI” >  tab menu: Home > grup Styles:  Heading 

1 

•  teks “REFRENSI” >  tab menu: Home > grup Styles:  Heading 1 

• Sedangkan untuk teks yang tersisa, selain judul. Pilih Styles: Heading 2 

Memperbaiki urutan nomor  

Kalau kita perhatikan hasil dari pemilihan Style diatas, secara otomatis baris-baris tertentu 

secara otomatis diberi nomor sesuai dengan style-nya. Namun, untuk teks ”Strategi e-

Business” diberikan numbering “E”. Kita akan merubahnya sehingga setiap bab yang 

berbeda, numbering huruf harus diawali dengan “A” 

• R teks “E.” Yang menjadi Number pada kalimat “Stategi Businnes” >  Restart at A  

 
Berikut dibawah ini adalah contoh halaman dokumen hasil dari memilih style sebelum 

kita akan memulai menata section: 

Klik Kanan disini 
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Gambar 47. hasil pemilihan Style untuk menata Section 

Membuat Section Judul 

• Buatlah baris kosong setelah teks “judul” dengan meletakkan kursor pada akhir teks 

“Judul” > tekan ENTER 

•  tab menu: Layout > pada grup Page Setup:  ikon Breaks   

• Kemudian pilih Next Page ( ) 

• Secara otomatis “Judul” akan terpisah halaman dengan teks berikutnya 

Membuat Section Daftar Isi 

Lanjutkan dengan membuat section “Daftar Isi”: 

• Buatlah baris kosong setelah teks Daftar Isi dengan meletakkan kursor pada akhir teks 

“Daftar Isi” > tekan ENTER 
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•  tab menu: Layout > pada grup Page Setup:  ikon Breaks >  Next Page 

• Secara otomatis “Daftar Isi” akan terpisah halaman dengan teks sebelumnya yaitu judul 

Membuat Section Daftar Gambar, Bagan, dan Tabel 

• Buatlah baris kosong setelah teks Daftar Gambar, Bagan, dan Tabel dengan meletakkan 

kursor pada akhir teks “Daftar Gambar, Bagan, dan Tabel” > tekan ENTER 

•  tab menu: Layout > pada grup Page Setup:  ikon Breaks >  Next Page 

• Secara otomatis “Daftar Gambar, Bagan, dan Tabel” akan terpisah halaman dengan teks 

sebelumnya 

Membuat Section Bab-1 

• Buatlah baris kosong setelah teks BAB I. PENDAHULUAN dengan meletakkan kursor 

pada akhir teks “BAB I. PENDAHULUAN” > tekan ENTER 

•  tab menu: Layout > pada grup Page Setup:  ikon Breaks >  Next Page 

• Secara otomatis “BAB I. PENDAHULUAN” akan terpisah halaman dengan teks 

sebelumnya 

Membuat Section Bab-2 

• Buatlah baris kosong setelah teks BAB II. STRATEGI DAN PENERAPAN dengan 

meletakkan kursor pada akhir teks “BAB II. STRATEGI DAN PENERAPAN” > tekan 

ENTER 

•  tab menu: Layout > pada grup Page Setup:  ikon Breaks >  Next Page 

• Secara otomatis “BAB II. STRATEGI DAN PENERAPAN” akan terpisah halaman 

dengan teks sebelumnya 

Membuat Section di teks berikutnya 

• Ulangi langkah-langkah diatas untuk membuat section disetiap bab yang tersisa, termasuk 

referensi. 

 

Membuat rancangan header dan footer yang berbeda setiap section 

Berikut ini adalah rencana pembuatan header/footer dan penomoran halaman (page numbering) 

berikut jenis penomoran halaman yang akan kita buat: 

Judul : tidak punya nomor halaman/header/footer 

Daftar isi : ada teks di header, footer berupa nomor halaman: i, ii, 

iii... 

Daftar Gambar, Bagan, Tabel : ada teks di header, footer berupa nomor 

halaman: i, ii, iii... (nomor halaman tersambung dengan 

section Daftar isi) 

Bab 1, bab 2, dst... : header setiap bab teks berbeda, footer berupa nomor 

halaman: 1, 2, 3... (nomor halaman tersambung dengan 

bab-bab lainnya) 

Referensi : tidak ada header, footer berupa nomor halaman: a, b, c... 
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Section Judul 

Halaman judul biasanya tidak pernah diberikan header dan footer, oleh karena kita tidak perlu 

menciptakan header maupun footer di section untuk judul ini. Namun desainlah halaman judul 

ini sesuai dengan kreatifitas anda. Sebagai teks pembantu untuk desain, anda bisa tuliskan: 

• Judul: “Manajemen e-Business dan e-Commerce” 

• Penulis: masukkan nama anda 

• Tahun: masukkan tahun pembuatan dokumen/buku 

 

File Background  

Download Untuk merancang latar belakang halaman judul, anda bisa 

merancangnya sendiri atau dengan memindai (download) di: 

  program Google Chorme > pada Address bar, masukkan alamat 

website: 

www.stietrisakti.ac.id/download/labaplikom/msword/ 

 

Mengaktifkan Header & Footer 

•  tab menu: Insert > grup Header & Footer:  Footer > ikon Edit Footer (

) 

 

Section Daftar Isi 

• Kita akan membuat footer untuk daftar isi, berikut langkahnya: 

•  di area Header pada  section daftar isi >  Tab menu: Design > pada grup Navigation: 

 untuk non aktifkan ikon Link to Previous ( ) 

• Gulung (scrolling) layar kebawah 

•  di area Footer pada section daftar isi >  Tab menu: Design > pada grup Navigation: 

 untuk non aktifkan ikon Link to Previous ( ). 
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Gambar 48. tombol dan informasi untuk section yang harus diperhatikan 

 

 

Section Daftar gambar, bagan, dan tabel 

• Header: Non aktifkan ikon Link to Previous  

• Footer : aktifkan ikon Link to Previous  

Section Bab I 

• Header: Non aktifkan ikon Link to Previous  

• Footer : Non aktifkan ikon Link to Previous  

 

Section Bab II dan Bab III 

• Header: Non aktifkan ikon Link to Previous di section Bab II dan Bab III 

• Footer : Biarkan  aktif  ikon Link to Previous di section Bab II dan Bab III 

Section Referensi 

• Header: Non aktifkan ikon Link to Previous  

• Footer : Non aktifkan ikon Link to Previous  

 

D. MENGATUR PAGE NUMBERING 

 

Menciptakan dan Menata Isi Header dan Footer 

Section Daftar Isi 

• Melanjutkan latihan sebelumnya, aktifkan area header dan footer 

•  di area Header pada  section Daftar Isi 

•   “| Daftar Isi |” di posisi Right Tab (gunakan TAB untuk memindahkan ke Right Tab) 

Area kerja dokumen dalam 
keadaan non aktif 

Area Footer dalam keadaan 
aktif 

Area Header dalam keadaan 
aktif 

Ikon untuk aktif/non aktifkan (on/off) hubungan satu 
section dengan section yang lainnya 
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•  di area Footer pada  section Daftar Isi 

•  Tab Menu: Insert > pada grup Header & Footer:  ikon Footer > Bottom of Page 

> Three Lines 

 

• Otomatis tercipta nomor halaman di footer anda, modifikasi nomor halaman dengan 

langkah-langkah: 

•  Tab menu: Design (Header & Footer Tools) > grup: Header & Footer >  ikon Page 

Number >  Format Page Numbers... > maka akan muncul kotak dialog Page Number 

Format 

• Pada kotak dialog Page Number Format > tentukan: 

o Number Format: i, ii, iii,... 

o Start at: i >  OK 
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Gambar 49. Memodifikasi format halaman 

Section Daftar Gambar, Bagan, dan Tabel 

•  di area Header pada  section Daftar Gambar, Bagan, dan Tabel 

•   “|Daftar Gambar, Bagan, dan Tabel |” di posisi Right Tab 

•  di area Footer pada  section Daftar Gambar, Bagan, dan Tabel 

• Karena footer merupakan kelanjutan dari section sebelumnya, maka kita bisa langsung 

menemukan disain footer yang sama dengan section Daftar Isi 

• Kita hanya perlu memastikan format nomor halamannya saja, dengan cara: 

•  di area footer >  Tab menu: Design (Header & Footer Tools) > grup: Header & 

Footer >  ikon Page Number >  Format Page Numbers... > pada kotak dialog Page 

Number Format > tentukan: 

o Number Format: i, ii, iii,... 

o  “Continue from previous section” >  OK 

Section Bab I, Bab II, dan Bab III 

• Header Bab I  :   “|Bab I - Pendahuluan |” di posisi Right Tab 

• Header Bab II  :   “|Bab I – Strategi dan Penerapan |” di posisi Right Tab 

• Header Bab III :   “|Bab I - Implementasi |” di posisi Right Tab 

• Footer Bab I :  Tab Menu: Insert > Header & Footer:  Page Number >  Bottom 

of Page >  Three Lines 

•  di area footer >  Tab menu: Design (Header & Footer Tools) > grup: Header & 

Footer >  ikon Page Number >  Format Page Numbers... > pada kotak dialog Page 

Number Format > tentukan: 

o Number Format: 1, 2, 3,... 

o Start at : “1” >  OK 

 

Section Referensi 

• Header Referensi  :   “|Referensi |” di posisi Right Tab 

• Footer Bab I :  Tab Menu: Insert > Header & Footer:  ikon Footer >  Three Lines 
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•  di area footer >  Tab menu: Design (Header & Footer Tools) > grup: Header & 

Footer >  ikon Page Number >  Format Page Numbers... > pada kotak dialog Page 

Number Format > tentukan: 

o Number Format: a, b, c,... 

o Start at : “a” >  OK 

 

E. PENGGUNAAN FORMAT PAINTER 

 

Format Painter pada Microsoft Office digunakan untuk menyalin atau meniru suatu 

format yang telah ada pada suatu text, graphics, atau cell kepada suatu target yaitu text, 

graphics, atau cell lainnya pada dokumen yang sama. 

 

Berikut adalah cara penggunaan Format Painter : 

•  pada text, graphics, atau cell yang formatnya ingin disalin. 

• Tab Home >  Format Painter atau Double- Format Painter jika terdapat lebih dari 

satu target. 

 
Gambar 50. Penggunaan Format Painter 

• Pointer akan berubah menjadi gambar kuas. 

•  pada text, graphics, atau cell yang menjadi target. 

 

 

 

F. MEMBUAT DAFTAR ISI, DAFTAR TABEL, DAN DAFTAR GAMBAR 

 

Kelebihan dari pembuatan dokumen dengan menggunakan section adalah dalam 

membuat perbedaan rancangan dokumen di setiap section dan membuat dengan mudah daftar 

isi, tabel, gambar, maupun bagan. 

Menutup header dan footer 

• Tutup area header dan footer dengan cara:  tab menu: Design > grup Close:  ikon 

Close Header and Footer 

Membuat Daftar Isi 

•  di halaman Daftar Isi 



Trisakti School of Management  

Data Modeling and Visualization Laboratory/P24.25 

Hanya untuk digunakan di lingkungan TSM!  Page 106 of 178 

• Letakkan kursor di baris tepat dibawah judul “Daftar Isi” (gunakan klik ganda di bawah 

judul apabila tidak terdapat baris kosong) 

•  tab menu: References > pada grup Table of Contents:  ikon Table of Contents > 

“Automatic Table 2” 

• Maka akan tercipta secara otomatis daftar isi yang sudah lengkap dengan nomor 

halamannya 

• Hapuslah teks “Table of Contents” di halaman daftar isi anda. 

• Blok semua baris daftar isi yang tercipta >  tab menu: Home > grup Paragraph:  ikon 

Line Spacing ( ) >  1,0 

Menyisipkan Contoh Gambar 

• Sisipkanlah sembarang gambar untuk latihan di sembarang baris dibawah sub-bab antara 

Bab 1, 2, atau 3. 

•  tab menu: Insert > grup Illustrations:  ikon Picture > ambil sebuah gambar contoh 

>  tombol Insert 

• Pada gambar yang disisipkan: 

• R pada gambar > pada pop-up menu:  Insert Caption... > maka keluarkotak dialog 

Caption 

• Pada kotak dialog Caption > New Label >  “Gambar” > Label: Gambar, Position: 

Bellow selected item, Caption: Gambar 1 “Gambar Contoh” >  OK 

Membuat Daftar Gambar 

• Pindahkan kursor di baris kosong di halaman daftar gambar, bagan, dan tabel 

•  pada baris kosong: “Daftar Gambar:” > ENTER 

•  tab menu: References > pada grup Captions:  ikon Insert Table of Figures  

( ) > maka akan keluar kotak dialog “Table of Figures” 

• Pada kotak dialog “Table of Figures” > pilih Caption label: Gambar >  OK 

• Maka secara otomatis akan tercipta daftar gambar termasuk halamannya. 
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Gambar 51. Kotak dialog Table of Figures 

 

Mengupdate daftar isi, gambar, tabel, dan bagan apabila ada perubahan 

Apabila ada penambahan atau pengurangan bab, sub-bab, sub-judul, halaman, jumlah 

gambar, judul gambar, jumlah tabel, judul tabel, dan lainnya, maka kita akan dengan mudah 

bisa mengupdate daftarnya dengan cara sebagai berikut: 

•  di salah satu baris pada daftar isi 

• Tekan F9 di keyboard komputer, atau  

•  tab menu: References > grup Table of Contents:  Update Table, atau 

•  disembarang baris daftar isi, maka akan muncul ikon Update Table... di frame. 

 
Gambar 52. Mengupdate daftar isi  
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G. MEMBUAT KUTIPAN DAN DAFTAR PUSTAKA 

1. Membuat Kutipan 

Penulisan karya ilmiah seperti skripsi, tesis, disertasi, jurnal ilmiah dan sebagainya, 

biasanya  mengutip dari sumber lain. Kutipan dapat dibuat secara otomatis melalui fitur yang 

terdapat pada Ms-Word. Untuk lebih jelasnya, perhatikan pembahasan berikut: 

1. Sebelum Anda membuat kutipan, tentukan Style untuk kutipan (Citation) dengan cara  

drop-down tombol Style pada tab REFERENCES – grup Citations & 

Bibliography. Klik nama style yang ingin Anda gunakan. Sebagai contoh pilih style 

“Chicago”. 

 
2. Letakkan insertion point pada akhir kalimat atau bagian yang akan ditambahkan kutipan. 

 

 

 

 

 

3. Pada tab REFERENCES – grup Citations & Bibliography,  tombol Insert Citation 

dan pilih Add New Source pada daftar drop-down yang tampil, sehingga tampil kotak 

dialog Create Source.  

Teori keagenan menjelaskan hubungan keagenan sebagai sebuah kontrak di 

mana satu atau lebih orang (principal) melibatkan orang lain (agent) untuk 

melaksanakan beberapa layanan atas nama mereka dengan melakukan pendelegasian 

wewenang pengambilan keputusan kepada agent | 

 
Letakkan Insertion Point disini 
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4. Pada kotak dialog Create Source,  tombol drop-down Type of Source, pilih sumber 

kutipan. Sebagai contoh pilih Journal Article, kemudian ketikan informasi tentang 

sumber. 

 
5. Jika semua informasi telah terisi, setelah itu  OK. Hasil kutipan sebagai berikut. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Teori keagenan menjelaskan hubungan antara investor atau pemegang saham 

sebagai principal dan manajer sebagai agent. Manajer adalah orang yang ditunjuk 

oleh pemegang saham untuk melayani kepentingan mereka. Oleh karena itu, 

manajemen bertanggung jawab kepada pemegang saham yang berkaitan dengan 

pekerjaan atau kinerjanya (Jensen and Meckling 1976) 

 
Hasil Kutipan 
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2. Membuat Daftar Pustaka 

Daftar Pustaka adalah sebuah daftar yang mencatumkan judul buku, nama pengarang, 

penerbit dan sebagainya yang ditempatkan pada bagian akhir suatu karangan atau buku. 

Berikut ini adalah langkah-langkah untuk membuat daftar pustaka: 

1. Aktif pada lembar kerja Ms Word yang kosong atau berada di halaman daftar pustaka. 

 
2. Pada tab REFERENCES – grup Citation & Bibliography,  drop-down tombol Insert 

Citation, kemudian  Add New Source sehingga tampil kotak dialog Create Source.  

Isi semua informasi sumber, sebagai contoh sumber buku sebagai berikut. 

 
3.  OK setelah selesai mengisi informasi sumber buku tersebut. 

4. Untuk menampilkan daftar pustaka berdasarkan sumber-sumber yang telah dimasukkan, 

pada tab REFERENCES – grup Citation & Bibliography,  drop-down tombol 

Bibliography, kemudian  tombol Insert Bibliography.  
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5. Tampilan Daftar Pustaka adalah sebagai berikut. 
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H. PRAKTIKUM MS WORD LANJUTAN 2016 - 1 
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Ketentuan Soal Praktikum MS WORD Lanjutan: 

1. Ukuran Kertas A4, Margin Normal 

2. Ketentuan Cover Makalah (tidak diberi nomor halaman): 

• Font: Arial 

• Tulisan “MAKALAH EKONOMI … DAN MONETER” memiliki Font Size:: 

18, Bold 

• Tulisan “Disusun Oleh” memiliki Font Size: 14, Bold 

• Tulisan “Penulis” memiliki Font Size: 14, Regular 

• Tulisan “Trisakti School … 2019” memiliki Font Size: 16, Bold 

3. Ketentuan Style Soal Praktikum MS WORD Lanjutan: 

 Heading 1 Heading 2 Heading 3 Normal 

Font Arial Arial Calibri Calibri 

Font Style Bold Bold Bold Regular 

Size 16 14 12 12 

Font Color Black Brown Black Black 

Spacing 

before 

0 pt 0 pt 0 pt 0 pt 

Spacing after 0 pt 0 pt 0 pt 0 pt 

Line Spacing Single 1,5 lines 1,5 lines 1,5 lines 

Alignment Center Justified Justified Justified 

Shading Blue None None None 

4. Daftar Pustaka menggunakan style Chicago dan tidak diberi nomor halaman. 
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I. PRAKTIKUM MS WORD LANJUTAN 2016 - 2 
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Ketentuan Soal Praktikum 2 MS WORD Lanjutan: 

1. Ukuran Kertas A4, Margin Atas 3cm, bawah 4cm, kiri 4 cm, kanan 3cm.  

2. Ketentuan Cover Makalah (tidak diberi nomor halaman): 

a) Font: Times New Roman 

b) Tulisan “PENGEMBANGAN SENI … PANTI ASUHAN” memiliki Font Size: 

18, Bold 

c) Tulisan “Disusun Oleh” memiliki Font Size: 14, Bold 

d) Tulisan “Penulis” memiliki Font Size: 14, Regular 

e) Tulisan “Trisakti School … 2024” memiliki Font Size: 16, Bold 

3. Ketentuan Style Soal Praktikum MS WORD Lanjutan: 

 Heading 1 Heading 2 Heading 3 Normal 

Font Tahoma Arial Calibri Times New 

Roman 

Font Style Bold, Underline, 

Italic 

Bold Bold Regular 

Size 16 14 12 12 

Font Color Red Blue Accent 5 Black Black 

Indentation 

Before 

0 cm 0 cm 0 cm 0 cm 

Indentation 

After 

0 cm 0 cm 0 cm  0 cm 

Spacing 

Before 

0 pt 6 pt 0 pt 0 pt 

Spacing 

After 

0 pt 6 pt 0 pt 0 pt 

Line Spacing Single 1,5 lines 1,5 lines 1,5 Lines 

Alignment Center Justified Justified Justified 

Shading Gold None None None 

 

4. Daftar pustaka Menggunakan Chicago dan tidak diberi nomor halaman 
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J. PRAKTIKUM MS WORD LANJUTAN 2016 - 3 
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Ketentuan Praktikum 3 MS WORD Lanjutan: 

1. Ukuran Kertas A4, Margin Normal. 

2. Ketentuan Cover Makalah (tidak diberi nomor halaman): 

a. Font: Times New Roman 

b. Tulisan “MAKALAH KOMUNIKASI” memiliki Font Size: 16, Bold 

c. Tulisan “Pers di Berbagai … Indonesia” memiliki Font Size: 14, Reguler 

dengan Font Castellar 

d. Tulisan “Disusun Oleh” memiliki Font Size: 14, Bold dengan Font Book 

Antiqua 

e. Tulisan “Penulis” memiliki Font Size: 14, Bold dengan Font Algerian 

f. Tulisan “Trisakti School of Management……2024” memiliki Font Size: 14, 

Bold dengan Font Broadway 

 

3. Ketentuan Style Soal Praktikum MS WORD Lanjutan: 

 Heading 1 Heading 2 Heading 3 Normal 

Font Times New 

Roman 

Times New 

Roman 

Aptos Times New 

Roman 

Font Style Bold Bold, Italic Italic, 

Underline 

Reguler 

Size 14 12 12 12 

Font Color Orange, 

Accent 2, 

Darker 25% 

Red Orange Accent 

2, Darker 50% 

Black 

Indentation 

Before 

0 cm 0 cm 0 cm 0 cm 

Indentation 

After 

0 cm 0 cm 0 cm 0 cm 

Spacing Before 0 pt 0 pt 0 pt 0 pt 

Spacing After 0 pt 0 pt 0 pt 0 pt 

Line Spacing 1,5 lines 1,5 lines 1,5 lines 1,5 lines 

Alignment Center Justified Justified Justified 

Shading None None None None 

Border Yes None None None 

 

Daftar Pustaka menggunakan style Chicago dan tidak diberi nomor halaman
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BAB VII MS EXCEL 2016 

  

 

Topik Utama 

✓ Mahasiswa mengetahui fungsi program MS Excel 

✓ Mahasiswa mengenal bagian-bagian dasar dari window 

program MS Excel 2016 

✓ Mahasiswa menguasai penggunaan sel-sel MS Excel 

✓ Mahasiswa mampu memanfaatkan pengelompokan data 

kedalam tab sheet 

✓ Mahasiswa mampu menentukan format Layout 

✓ Mahasiswa menguasai pembuatan tabel dengan manual ataupun 

secara otomatis 

✓ Mahasiswa mampu menata tabel beserta teksnya 

✓ Mahasiswa mengenal penggunaan fungsi-fungsi untuk 

mengolah data 

✓ Mahasiswa mampu menyisipkan grafik 3-D 

 

 

Hubungan dengan Bab lainnya 

✓ Bab I yang membahas tentang Microsoft Office 2016 

 

 

Pertanyaan Umum 

✓ Bagaimana anda menentukan harus menggunakan program MS 

Excel daripada menggunakan program MS Office lainnya? 

✓ Bagaimana anda menentukan pembagian data kedalam 

beberapa worksheet? 

✓ Kepada siapa anda harus membuat laporan denan menggunakan 

grafik (chart)? 

  

Praktikum  Memahami fungsi program MS Excel 

 Membaca letak sel dan range sel 

 Mengenal dan menggunakan fungsi Tab Sheet 

 Membuat tabel dengan format otomatis dan manual 

 Menguasai penataan tabel dan teksnya 

 Mengenal cara menggunakan formula dari fungsi-fungsi yang ada di MS 

Excel 

 Membuat 3-D Chart 
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A. PENGENALAN DASAR MS EXCEL 2016 

Microsoft Excel adalah sebuah program aplikasi lembar kerja spreadsheet yang 

didistribusikan oleh Microsoft. Program Excel memiliki fitur kalkulasi dan pembuatan grafik 

yang cukup handal. Excel memang dikenal dengan penggunaan rumus-rumus yang dapat 

mempermudah Anda dalam membuat suatu laporan. 

 

B. SETTING FORMAT WINDOWS YANG DIGUNAKAN 

 

Dalam modul ini setting format windows yang digunakan adalah Setting Format 

Windows Indonesian (Indonesia), sehingga format data dan tanda pemisah argumen atau list 

separator sesuai dengan ketentuan format Indonesia. 

Berikut langkah-langkah untuk mengatur setting format windows: 

1. Membuka Control Panel  

2. Ubah View by: Category menjadi View by: Large icons/Small Icons 

 
3.  ikon Region sehingga tampil kotak dialog Region 

4.  tombol drop- down  Format, kemudian pilih setting format yang diinginkan. 

 Indonesian (Indonesia), sehingga bentuk format untuk data tanggal dan waktu sesuai 

dengan format Indonesia.  OK. 
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C. MEMBUKA PROGRAM MICROSOFT OFFICE EXCEL 2016 

 

Berikut langkah-langkah untuk membuka program MS Word 2016: 

•  Start > Microsoft Office Excel 2016 >  Blank workbook 

Klik drop 
down disini 



Trisakti School of Management  

Data Modeling and Visualization Laboratory/P24.25 

Hanya untuk digunakan di lingkungan TSM!  Page 133 of 178 

 
 Gambar 53. Tampilan MS Excel 2016  

 

1. Quick Access Toolbar 

2. Tab menu / Ribbon Tab 

3. Nama file dokumen workbook 

4. Help 

5. Tombol Pengaturan Window 

6. Name Box 

7. Cell 

9. Column 

10. Insert Formula 

11. Formula Bar 

12. Tab sheet 

13. Insert sheet 

14. Pengatur tampilan area kerja sheet 

15. Zoom 

2 1 3 4 

6 

8 

12 13 

9 
10 

11 

14 

16 

15 

5 

7 
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8. Row 16. Share 

1. Membaca letak sel dan range 

 

Didalam menggunakan worksheet, sangat penting untuk memahami petunjuk sel, 

petunjuk range, menentukan sel dan menentukan range. 

 
Gambar 54. pointer menunjukan pemilihan sel tunggal 

 

 
Gambar 55. pointer menunjukan pemilihan beberapa sel 

 

2. Menambah, memindahkan dan menghapus sheet di Tab Sheet 

 

Worksheet di tab sheet bisa ditambah maupun dihapus, berikut langkah-langkahnya: 

• Tambahlah Worksheet baru dengan cara: 

o Pada Tab Sheet:  ikon insert Worksheet ( ), atau tekan SHIFT+F11 

• Memindahkan Worksheet baru dengan cara: 

o Pada Tab Sheet: → pindahkan sheet yang dipilih ke tempat yang anda inginkan 

selama masih diarea tab sheet 

 

Letak pointer 

Alamat kolom 

Alamat baris 

Alamat sel: C4 = Kolom ‘C’ dan Baris ke ‘4’ 

Alamat sel: B2 = sel yang aktif 
dan siap menerima input 

Range kolom yang dipilih 

Range baris yang dipilih 

Range yang dipilih: 
B2:D6 
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Gambar 56. Memindahkan workshet 

• Menghapus Worksheet dengan cara: 

o Pada Tab Sheet: R pada sheet 2, 3 , dan 4 yang ingin kita hapus > pada pop-up 

menu >  Delete 

 

 

Berikut gambar dari hasil membuat workbook excel yang akan kita buat:  

 
Gambar 57. Worksheet  

3. Mengubah nama-nama sheet di Tab Sheet 

Nama worksheet bisa diubah dengan cara: 

• Pada Tab Sheet: R Sheet1 > pada menu pop-up:  Rename, atau 

• Pada Tab Sheet  Sheet1. Gantilah nama Sheet1 menjadi: “Daftar Pembeli Tahun 

2016” 

 

4. Menyimpan workbook 

Didalam MS Excel, sebuah workbook disimpan dalam sebuah file. Untuk menyimpan 

workbook kita bisa melakukan langkah-langkahnya sama seperti aplikasi MS Office lainnya. 

Klik disini 

Pindahkan 

Lepaskan 
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•  tombol Office >  Save > pada kotak dialog Save yang muncul:  

o Buatlah folder “latihan Excel 2016” di direktori latihan anda 

o Simpan workbook dengan nama file: “latihan workbook MS Excel – 1.xlsx” 

o  tombol Save 

 

Info  

Jumlah Baris, 

Kolom, dan sel 

• MS Excel 2016 secara default mempunyai 16.384 kolom dan 

1.048.576 baris.  

• Berarti pada MS Excel 2016 terdapat 17.179.869.184 sel yang bisa 

kita gunakan 

 

5. Membuat setup Layout setiap worksheet 

Sebelum kita menentukan ukuran halaman dari sebuah worksheet maka kita tidak akan 

bisa menemukan garis-garis pembatas halaman. Selain itu, didalam menentukannya kita bisa 

membedakan ukuran halaman antara worksheet satu dengan worksheet yang lainnya didalam 

satu workbook. 

Didalam praktikum ini kita akan menentukan ukuran halaman sebagai berikut: 

• Pada tab sheet:  “Daftar Pembeli Tahun 2016” : 

o  tab menu: Page Layout >  grup: page Setup >  ikon Size >  Legal 

o  tab menu: Page Layout >  grup: page Setup >  ikon Orientation >  

Landscape 

 

D. PENGGUNAAN FILTER DATA 

 

Untuk memudahkan pengelolahan data pada Microsoft Excel, terdapat Filter yang 

berguna untuk memfokuskan data yang ingin kita lihat. Terdapat banyak hal yang dapat 

dilakukan filter seperti kalimat, tanggal, dan angka.  

 

Untuk mencoba fungsi filter ini, telah disediakan dokumen yang bisa Mahasiswa/i 

dapatkan melalui link yang akan diberikan oleh Instruktur Lab. Sebelumnya Mahasiswa/i 

diharuskan mengisi cell yang kosong dengan menggunakan ketentuan pada “Praktikum Ms 

Excel 2016 – 2”. 

 

Didalam praktikum ini kita akan menggunakan Filter sebagai berikut: 

• Melakukan blok pada data header yang ingin dilakukan Filter.  
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• Pada tab Data,  Filter pada grup Sort & Filter. 

 
 

Atau dapat diakses melalui tab Home >  Sort & Filter pada grup editing >  Filter 

 

• Setelah itu maka akan muncul tombol  pada header data. 

•   pada kolom yang ingin dilakukan filter. 

 

• Maka akan muncul Filter menu sebagai berikut. 
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• Klik  pada sebelah kalimat, tanggal atau angka yang diinginkan sehingga menjadi  > 

 OK 

 

• Sehingga data yang ditampilkan akan seperti berikut. 
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• Untuk mendapatkan data yang lebih fokus, maka kita dapat menambahkan filter tambahan 

lebih dari satu. 

 

E. MENGOLAH DATA 

 

Kelebihan dari MS Office Excel adalah kemampuannya untuk mengolah data. 

Pengolahan di MS Excel antara lain dengan memanfaatkan fungsi-fungsi: Auto Sum, 

Financial, Logical, Text, Date & Time, Lookup & Refference, Math & Trig, Statistical, 

Engineering, Cube, dan Information. 

Pada modul ini tidak dibahas semua fitur-fitur fungsinya, namun ada beberapa fungsi 

yang sering bermanfaat di dalam pengolahan data sehari-hari akan kita lakukan langkah-

langkahnya. Fungsi-fungsi yang akan dibahas adalah sebagai berikut: 

• Fungsi CONCATENATE (“&” 

dapat dijadikan alternatif untuk 

fungsi ini) 

• Fungsi LEFT 

• Fungsi RIGHT 

• Fungsi MID 

• Fungsi VALUE 

• Fungsi SUM 

• Fungsi AVERAGE 

• Fungsi MIN 

• Fungsi MAX 

• Fungsi MEDIAN 

• Fungsi CONVERT 

• Fungsi NOT 

• Fungsi HLOOKUP 

• Fungsi VLOOKUP 

• Fungsi YEAR 

• Fungsi MONTH 

• Fungsi DAY 

• Fungsi AND 

• Fungsi OR 

• Fungsi IF 

• Fungsi SUMIF 

• Fungsi SUMIFS 

• Fungsi COUNTIF 

• Fungsi COUNTIFS 

• Fungsi MATCH 

• Fungsi INDEX 
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Penggunaan rumus yang tidak tepat dapat menyebabkan munculnya error pada formula 

excel yang digunakan maupun format yang salah. Error-error pada excel yang diakibatkan oleh 

penggunaan rumus formula maupun format yang salah adalah sebagai berikut: 

• #DIV/0! 

• ###### 

• #VALUE! 

• #NAME? 

• #REF! 

• #NULL! 

• #N/A 

• #NUM! 

 

Tugas: 

Untuk mempermudah memahami penggunaan formula dalam excel, Mahasiswa/i diminta 

untuk: 

1. Mencari kegunaan serta membuat contoh dari fungsi-fungsi diatas. 

2. Mencari arti dari error-error diatas. 
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F. NUMBER FORMAT PADA MS EXCEL 2016 

 
Number Format ini berfungsi untuk mengubah angka yang akan di tampilkan pada 

lembar kerja excel. Terdapat beberapa format number yang akan dibahas yaitu: 

Format Deskripsi 

General Format angka default yang diterapkan oleh Excel bila Anda mengetikkan 

angka. Sebagian besar, angka yang diformat menggunakan 

format General akan ditampilkan sama dengan angka yang Anda 

ketikkan. Namun, jika sel kurang lebar untuk memperlihatkan seluruh 

angkanya, format General akan membulatkan angka tersebut dengan 

 Tab Home 

  Dialog Box Launcher 

Pilih Format yang diinginkan 
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Format Deskripsi 

desimal. Format angka General juga menggunakan notasi ilmiah 

(eksponensial) untuk angka besar (12 digit atau lebih). 

Number Digunakan untuk tampilan angka umum. Anda dapat menentukan jumlah 

tempat desimal di belakang koma yang ingin Anda gunakan, apakah Anda 

ingin menggunakan pemisah ribuan, dan bagaimana Anda ingin 

menampilkan bilangan negatif. 

Currency Digunakan untuk nilai mata uang umum dan menampilkan simbol mata 

uang default dengan angka. Anda dapat menentukan jumlah tempat 

desimal di belakang koma yang ingin Anda gunakan, apakah Anda ingin 

menggunakan pemisah ribuan, dan bagaimana Anda ingin menampilkan 

bilangan negatif. 

Accounting Juga digunakan untuk nilai mata uang, tetapi format ini meluruskan 

simbol mata uang dan koma desimal angka dalam kolom. 

Date Menampilkan nomor seri tanggal dan waktu sebagai nilai tanggal, sesuai 

dengan tipe dan lokal (lokasi) yang Anda tentukan. Format tanggal yang 

diawali dengan tanda bintang (*) akan merespons perubahan dalam 

pengaturan tanggal dan waktu wilayah yang ditentukan dalam Control 

Panel. Format tanpa tanda bintang tidak akan dipengaruhi oleh pengaturan 

Control Panel. 

Time Menampilkan nomor seri tanggal dan waktu sebagai nilai waktu, sesuai 

dengan tipe dan lokal (lokasi) yang Anda tentukan. Format tanggal yang 

diawali dengan tanda bintang (*) akan merespons perubahan dalam 

pengaturan tanggal dan waktu kawasan yang ditentukan dalam Control 

Panel. Format tanpa tanda bintang tidak akan dipengaruhi oleh pengaturan 

Control Panel. 

Percentage Mengalikan nilai sel dengan 100 dan menampilkan hasilnya dengan 

simbol persen (%). Anda dapat menentukan jumlah tempat desimal yang 

ingin Anda gunakan. 

Fraction Menampilkan angka sebagai pecahan, sesuai dengan tipe pecahan yang 

Anda tentukan. 

Scientific Menampilkan angka dengan notasi eksponensial, menggantikan bagian 

angka dengan E+n, di mana E (kependekan dari Eksponen) mengalikan 

angka sebelumnya dengan 10 pangkat n. Misalnya, format dua 

desimal Ilmiah menampilkan 12345678901 sebagai 1,23E+10, yang 

berarti 1,23 kali 10 pangkat 10. Anda dapat menentukan jumlah tempat 

desimal yang ingin Anda gunakan. 

Text Memperlakukan isi sel sebagai teks dan menampilkan konten sama 

dengan yang Anda ketikkan, bahkan bila Anda mengetikkan angka. 
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G. REFERENSI ABSOLUT, SEMI ABSOLUT (RELATIF), DAN CAMPURAN 

Secara default, referensi sel adalah referensi relatif (semi absolut), yang berarti bahwa 

referensi relatif terhadap lokasi sel. 

Sebagai contoh, jika Anda menyalin rumus = B4 * C4 dari sel D4 untuk D5, rumus di 

D5 menyesuaikan ke kanan dengan satu kolom dan menjadi = B5 * C5. Jika Anda ingin 

mempertahankan referensi sel asli dalam contoh ini saat Anda menyalin, Anda membuat 

referensi sel absolut dengan cara mengawali kolom (B dan C) dan baris (2) dengan tanda dolar 

($). Lalu, saat Anda menyalin rumus = $B$4 * $C$4 dari D4 untuk D5, rumus tetap sama. 

 
Seringkali, terdapat campuran referensi sel absolut dan relatif dengan cara mengawali 

salah satu kolom atau baris nilai dengan tanda dolar (misalnya, $B4 atau C$4). 

Untuk mengubah tipe referensi sel: 

1. Pilih sel yang berisi rumus. 

2. Pada bilah rumus  , pilih referensi yang akan diubah. 

3. Tekan F4 untuk beralih antar tipe referensi.  

Tabel di bawah ini meringkas cara tipe referensi diperbarui jika rumus yang berisi 

referensi disalin dua sel ke bawah dan dua sel ke kanan. 

Untuk rumus yang 

disalin: 

Jika referensi adalah:  Akan berubah menjadi: 

 

$A$1 (kolom absolut dan 

baris absolut) 

➔ $A$1 (referensinya adalah 

absolut) 

 A$1 (kolom relatif dan 

baris absolut) 

➔ C$1 (referensinya adalah 

campuran) 

 $A1 (kolom absolut dan 

baris relatif) 

➔ $A3 (referensinya adalah 

campuran) 

 A1 (kolom relatif dan 

baris relatif) 

➔ C3 (referensinya adalah 

relatif) 
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H. PRAKTIKUM MS EXCEL 2016 - 1 

 

Buatlah sebuah tabel Daftar Pembelian Tahun 2016 seperti pada gambar berikut ini: 

Berikut adalah petunjuk untuk mengisi beberapa sel yang harus menggunakan formula: 

1. Karater pertama dan karakter terakhir diambil dari Kode Barang 

2. Grade diisikan dengan ketentuan: 

• Jika HG maka “High Grade” 

• Jika RG maka “Real Grade” 

• Jika MG maka “Master Grade” 

3. Kolom harga diisikan berdasarkan Tabel Bantuan 

Kolom hadiah diisikan berdasarkan Tabel Bantuan 
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I. PRAKTIKUM MS EXCEL 2016 - 2 

Buatlah sebuah table Pendapatan Tahun 2016, Seperti gambar berikut:  

 
Berikut adalah petunjuk untuk mengisi beberapa sel yang harus menggunakan formula: 

1. Kolom Merek: 

• Jika IB maka “IBANEZ” 

• Jika FN maka “Fender” 

• Jika GB maka “GIBSON” 

2. Kolom Nama Sales diisikan berdasarkan Tabel Bantuan 

3. Kolom Harga diisikan berdasarkan Tabel Bantuan 

4. Kolom Diskon diisikan dengan ketentuan sebagai berikut: 

• Jika tanggal pembelian terjadi pada tanggal 1-15 atau Mereknya IBANEZ, maka akan 

mendapatkan diskon sebesar 10% 

• Jika tanggal pembelian terjadi pada bulan Januari dan Mereknya Gibson, maka akan 

mendapatkan diskon sebesar 20%   

• Untuk pengisian kolom diskon sebaiknya menggunakan persentase agar Anda lebih 

mudah untuk memeriksanya 

5. Kolom pendapatan didapat dari (Harga -Diskon) x Jumlah  

6. Copy Sheet1 menjadi Sheet2 lalu sortir berdasarkan merek 

7. Buat Subtotal berdasarkan Sortir yang telah dilakukan 
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J. PRAKTIKUM MS EXCEL 2016 - 3 

Pada Praktikum 3 ini, Mahasiswa/i dapat mengakses link gdrive di bawah ini untuk 

mendownload file yang dibutuhkan untuk mengerjakan prak.  

https://drive.google.com/drive/folders/1OwDmCYQ93Pb-

xhLXlIKcEfuBQFgg4gQh?usp=sharing 

Berikut adalah petunjuk untuk mengisi beberapa sel yang harus menggunakan formula: 

1. Kode Aset memuat [AAABB-C-DDD-EEEEEEEE]: 

• AAA memberikan informasi tentang jenis aset. 

• BB memberikan informasi tentang merek aset. 

• C memberikan informasi tentang lokasi penempatan aset. 

• DDD memberikan informasi tentang jumlah aset pada lokasi bersangkutan. 

• EEEEEE memberikan informasi tentang tanggal pembelian aset. 

2. Kolom Tanggal Pembelian diisikan berdasarkan kode aset dengan format “mmmm 

yy”. 

3. Kolom Lokasi Aset, Jenis Aset dan Merek Aset dibuat berdasarkan tabel bantuan 

yang tersedia. 

4. Kolom Total Nilai Aset didapatkan dengan cara Jumlah Aset * Nilai Aset / Unit. 

5. Berikut adalah sebagian informasi untuk mengisi sel pada data ini: 

• Total Nilai Aset Ketentuan A adalah jumlah dari Total Nilai Aset dengan kriteria 

Lokasi Penempatan Aset di Bandung dan Nilai Aset / Unit lebih besar dari 

7.000.000. 

• Total Jumlah Aset Ketentuan B adalah jumlah dari Jumlah aset dengan kriteria 

Lokasi Penempatan Aset di Jakarta, Jenis Aset adalah Laptop dan Nilai Aset / 

Unit lebih kecil dari 7.000.000. 

• Total Nilai Aset Ketentuan C adalah jumlah dari Total Nilai Aset dengan kriteria 

Jenis Aset adalah Komputer dan Merek Aset adalah Samsul 

• Banyaknya Aset Ketentuan A adalah banyaknya aset dengan kriteria Merek Aset 

adalah Ar-Mine dan Lokasi Penempatan Aset di Bekasi. 

• Banyaknya Aset Ketentuan B adalah banyaknya aset dengan kriteria Jumlah Aset 

lebih dari tiga dan Merek Aset adalah Reca. 

 

Tambahan: 

Mahasiswa/i dapat menggunakan data ini sebagai latihan untuk menggunakan fitur Filter 

pada Microsot Excel. Ikuti instruksi yang diberikan oleh Instruktur Lab. 

 

 

 

 

 

 

 

https://drive.google.com/drive/folders/1OwDmCYQ93Pb-xhLXlIKcEfuBQFgg4gQh?usp=sharing
https://drive.google.com/drive/folders/1OwDmCYQ93Pb-xhLXlIKcEfuBQFgg4gQh?usp=sharing
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K. RAKTIKUM MS EXCEL 2016 - 4 

Buatlah sebuah table Pendapatan, seperti gambar berikut: 

 

Berikut adalah petunjuk untuk mengisi beberapa sel yang harus menggunakan formula: 

1. Kolom Jenis Nama Barang mempunyai ketentuan sebagai berikut: 

• Jika 2 karakter dari kiri “CC”, maka Nama Barang “Coklat” 

• Jika 2 karakter dari kiri “CK”, maka Nama Barang “Coklat Keju”

• Jika 2 karakter dari kiri “CP”, maka Nama Barang “Coklat Pisang” 

• Jika 2 karakter dari kiri “KK”, maka Nama Barang “Keju”

• Jika 2 karakter dari kiri “PK”, maka Nama Barang “Pisang Keju” 

2. Kolom Harga diisikan berdasarkan Tabel Bantuan 

• Biasa atau Special berdasarkan karakter ke-4 yang ada di dalam Kode Barang 

3. Kolom Potongan mempunyai ketentuan sebagai berikut: 

• Jika tanggal pemesanan terjadi pada tanggal 1-15 dan Jumlah pesanan lebih dari  sama 

dengan 100 dan Jenis Coklat/Keju-nya Ovomaltine atau Mozzarella, maka akan 

mendapatkan potongan sebesar 25% 

• Jika Jumlah pesanannya dari sama dengan 50 sampai sama dengan 100  (50-100) atau 

Jenis Coklat/Keju-nya Nutella, maka akan mendapatkan potongan sebesar 10% 

• Selain dari ketentuan diatas tidak mendapatkan potongan 

• Untuk pengisian kolom diskon sebaiknya menggunakan persentase agar Anda lebih 

mudah untuk memeriksanya 

4. Kolom Pendapatan  didapat dari (Harga x Jumlah) - Diskon 

5. Copy Sheet1 menjadi Sheet2 lalu sortir berdasarkan Jenis Coklat/Keju 

6. Buat Subtotal berdasarkan Sortir yang telah dilakukan
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L. PRAKTIKUM MS EXCEL 2016 - 5 

Buatlah sebuah table Penjualan Tahun 2019, Seperti gambar berikut:  

 

Berikut adalah petunjuk untuk mengisi beberapa sel yang harus menggunakan formula: 

1. Kode barang memuat [AA/BB/CC/DD/E] :  

• AA memberikan informasi tentang kualitas dari produk yang dipesan.  

• BB memberikan informasi tentang tanggal pemesanan dari produk yang dipesan.  

• CC memberikan informasi tentang kuantitas dari produk yang dipesan.  

• DD memberikan informasi tentang produk yang dipesan.  

• E memberikan informasi tentang pengiriman yang digunakan.   

2. Biaya Pengiriman (Rupiah) dibuat berdasarkan tabel bantuan waktu pengiriman 

yang tersedia pada soal dan dikalikan dengan tabel bantuan biaya pengiriman.  

3. Total Biaya (Rupiah) dibuat berdasarkan tabel bantuan yang tersedia dan dikalikan 

dengan biaya/unit yang didapat dari Kode Barang. Tabel bantuan yang tersedia 

menyajikan informasi mengenai biaya barang per unit.  

4. Markup (%) didapatkan berdasarkan ketentuan berikut:  

• Jika nama pembeli bukan Olanrewaju Thandi dan waktu pemesanan bukan awal 

bulan maka akan dilakukan markup sebesar 30%.  

• Jika nama pembeli bukan Mumtaz Theudemar dan waktu pemesanan akhir bulan 

maka akan dilakukan markup sebesar 24%.  

• Selain ketentuan a dan b maka akan dilakukan markup sebesar 21%.  

5. Diskon (Rupiah) didapatkan dari (Total Biaya (Rupiah) + (Markup % * Total Biaya 

(Rupiah))) * Diskon (%). Persentase diskon didapatkan dari ketentuan berikut:  
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• Jika kuantitas dari pemesanan kurang dari 10 dan waktu pemesanan bukan awal 

bulan maka akan diberikan diskon sebesar 9%.  

• Jika waktu pemesanan awal bulan dan nama pembeli bukan Enyinnaya Ibrahima 

maka akan diberikan diskon sebesar 7%.  

• Selain ketentuan a dan b maka akan diberikan diskon sebesar 0%.  

6. Total Harga (Rupiah) didapatkan dengan cara (Biaya Pengiriman (Rupiah) + Total 

Biaya (Rupiah) + (Markup % * Total Biaya (Rupiah)) - Diskon (Rupiah).  

7. Total didapatkan dengan cara menjumlahkan seluruh Total Harga (Rupiah).  

8. PETUNJUK NO 1 – 7 WAJIB DIKERJAKAN MENGGUNAKAN RUMUS 

YANG ADA PADA MS.EXCEL.  

9. Pada Sheet 2 buatlah data yang telah disortir berdasarkan Nama Pembeli dan 

BUATLAH SUBTOTAL berdasarkan sortir tersebut.  

10. BUAT PIVOT TABEL dengan ketentuan berikut:  

• Filter diisi oleh kolom Waktu pemesanan  

• Row diisi oleh kolom Nama Pembeli 

• Value diisi oleh kolom Total Biaya (Rupiah)  
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M. PRAKTIKUM MS EXCEL 2016 - 6 

 

 

Berikut adalah petunjuk untuk mengisi beberapa sel yang harus menggunakan formula: 

1. Kode Pesanan terdiri dari AA/AA/AAAA-B-CCC-D dengan ketentuan berikut: 

• AA/AA/AAAA : Tanggal/Bulan/Tahun Kirim 

• B   : Lokasi Tujuan 

- D : Delaware 

- M : Maine 

- V : Vermont 

- W : Wyoming 

• CCC   : Jumlah Unit 

2. Penerima adalah pelanggan Monday Express. 

3. Kode diisi menggunakan Kata Pertama Penerima-Lokasi Tujuan/Jumlah Unit lalu 

diakhiri kata Unit. Contoh: T-Delaware/128 Unit 
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4. Biaya Pengiriman adalah pendapatan kotor yang diterima oleh Monday Express, diisi 

dengan formula Biaya Pengiriman per Unit x Jumlah Unit dibuat berdasarkan tabel 

yang sudah disediakan. 

5. Semua Tabel diisi dengan menggunakan formula. 

6. Copy sheet 1 ke sheet 2 lalu lakukan sortir berdasarkan Penerima. 

7. Buatlah subtotal berdasarkan sortir yang telah dilakukan. 

8. Buatlah PivotTable dengan ketentuan sebagai berikut. 

• Filters diisi dengan Penerima. 

• Rows diisi dengan Kode. 

• Values diisi dengan Biaya Pengiriman. 

9. Desain Report Layout PivotTable dalam bentuk Outline.
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N. PRAKTIKUM MS EXCEL 2016 - 7 

 

 
 

Berikut adalah petunjuk untuk mengisi beberapa sel yang harus menggunakan formula: 

1. Nomor Registrasi terdiri dari AAA-BB-CCC dengan ketentuan berikut: 

• AAA : Kode Nomor Urut  

• BB  : Kekuatan layanan telepon (20 s/d 50 mbps) 

• CCC  : Status Hunian 

- APT  : Apartemen 

- RMH : Rumah 

2. Nama Pengguna adalah pendaftar layanan Away From Home. 

3. Paket adalah jenis layanan yang diambil dengan ketentuan berikut: 

- 1  : Single 

- 2 : Double 

- 3 : Triple 

4. Biaya Per Bulan merupakan biaya yang dikenakan sesuai paket yang dipilih. 

Perhitungan menggunakan tabel bantuan. 

5. Biaya Jaringan Apartemen merupakan biaya tambahan yang dikenakan apabila status 

hunian pengguna adalah Apartemen (APT). Perhitungan menggunakan tabel bantuan. 

6. Diskon merupakan potongan yang diberikan setiap bulannya dengan ketentuan berikut: 

• Jika nama pengguna bukan Tom Holland dan paketnya adalah Triple (3), maka 

diskon yang diberikan sebesar 8%. 
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• Jika kekuatan jaringan yang dipilih adalah lebih dari sama dengan 40 mbps atau 

paket yang dipilih adalah Double (2), maka diskon yang diberikan sebesar 5%. 

• Sisanya akan mendapat diskon 2%. 

7. Total Biaya/bulan adalah total biaya per bulan termasuk diskon yang diberikan kepada 

pengguna. Total Biaya/bulan = Biaya Per Bulan + Biaya Jaringan Apartemen – 

Diskon*). *) Perhitungan Diskon adalah %Diskon dikali Biaya Per Bulan. 

8. Semua Tabel diisi dengan menggunakan formula. 

9. Copy sheet 1 ke sheet 2 lalu lakukan sortir berdasarkan Nama Pengguna. 

10. Buatlah subtotal berdasarkan sortir yang telah dilakukan. 

11. Buatlah PivotTable dengan ketentuan sebagai berikut. 

• Filters diisi dengan Paket. 

• Rows diisi dengan : 

- Nama Pengguna 

- Diskon 

• Values diisi dengan Biaya Per Bulan dan Total Biaya/bulan. 
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O. PRAKTIKUM MS EXCEL 2016 - 8 

 

 

Berikut adalah petunjuk untuk mengisi beberapa sel yang harus menggunakan formula: 

1. Kode Vaksin terdiri dari AA-B/CD dengan ketentuan berikut: 

• AA   : Kode  

• B   : Jenis Vaksin (1,2,3,4) 

• C   : Sumbangan 

- Y : Ada 

- N : Tidak ada 

• D   : Nama Vaksin 

- S : Sinovac 

- A : AstraZeneca 

- M : Moderna 

- P : Pfizer 

2. Sponsor adalah pihak yang berkontribusi dalam dana pengembangan Queen’s 

Medicine. 

3. Kuantitas adalah jumlah vaksin yang telah diproduksi atas dana yang diberikan. 

4. Dana Pengembangan merupakan dana yang diterima untuk mengembangkan vaksin. 

Perhitungan menggunakan tabel bantuan dikali dengan kuantitas. 
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5. Dana Tambahan merupakan dana tambahan yang diberikan untuk penambahan 

kualitas vaksin. Perhitungan menggunakan tabel bantuan (tidak dikali kuantitas karena 

sifatnya umum) 

6. Biaya Pengedaran (%) merupakan biaya pengedaran vaksin yang telah dikembangkan 

dan dalam proses pengedaran dengan ketentuan berikut: 

• Jika kuantitas vaksin 100-150 unit dan sponsornya Kim Hye-soo, maka biayanya 

5%. 

• Jika jenis vaksin adalah 1 (V-1) atau kuantitas vaksin 151-200, maka biayanya 3%. 

• Sisanya dianggap biaya pengedaran sebesar 1%. 

7. Sisa Dana adalah total keseluruhan sisa dana yang diterima Queen’s Medicine. 

Sisa Dana = Dana Pengembangan + Dana Tambahan – Biaya Pengedaran* 

+ Sumbangan** 

*Biaya Pengedaran dihitung dari Dana Pengembangan dikali %Biaya Pengedaran. 

**Sumbangan tergantung ada/tidaknya (Y/N) pada kode vaksin tersebut. Jika 

ada  (Y) maka terdapat tambahan sumbangan 2% dari Dana Pengembangan. Jika tidak 

(N) maka tidak ada tambahan sumbangan. 

8. Semua Tabel diisi dengan menggunakan formula. 

9. Copy sheet 1 ke sheet 2 lalu lakukan sortir berdasarkan Sponsor. 

10. Buatlah subtotal berdasarkan sortir yang telah dilakukan. 

11. Buatlah PivotTable dengan ketentuan sebagai berikut. 

• Filters diisi dengan Sponsor. 

• Rows diisi dengan Kode Vaksin. 

• Values diisi dengan  

- Kuantitas. 

- Sisa Dana. 
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BAB VIII  MS EXCEL 2016 – LANJUTAN 1 
  

 

Topik Utama 

✓ Mahasiswa mengetahui fungsi-fungsi finansial di MS Excel 

yang biasa digunakan dalam analisis keuangan di dunia kerja. 

✓ Mahasiswa mampu mencoba beberapa fungsi finansial yaitu: 

SLN, PMT, PPMT, PV, FV, NPV dan IRR 

✓ Mahasiswa mampu menggunakan fungsi-fungsi finansial 

kedalam latihan kasus 

 

 

Hubungan dengan Bab lainnya 

✓ Bab V yang membahas tentang Microsoft Excel 

✓ Bab VII yang membahas tentang Microsoft Excel – Lanjutan 2 

 

 

Pertanyaan Umum 

✓ Bagaimana anda menghitung nilai penyusutan? 

✓ Bagaimana anda menghitung nilai angsuran? 

✓ Bagaimana anda menghitung nilai pokok pembayaran? 

✓ Bagaimana anda menghitung nilai investasi uang yang 

disimpan? 

✓ Bagaimana anda menghitung nilai uang yang akan datang? 

✓ Bagaimana anda menghitung nilai bersih investasi? 

✓ Bagaimana anda menghitung indikator tingkat efisiensi 

investasi? 

  

Praktikum  menghitung nilai penyusutan dengan SLN,  

 menghitung nilai angsuran dengan PMT 

 menghitung nilai pokok pembayaran dengan PPMT 

 menghitung nilai investasi uang yang disimpan dengan PV 

 menghitung nilai uang yang akan datang FV 

 menghitung nilai bersih investasi NPV 

 menghitung indikator tingkat efisiensi investasi dengan IRR 
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A. Financial Function 

 

Fungsi Finansial Microsoft Excel merupakan fungsi dalam Excel yang berkaitan 

dengan keuangan, akuntansi serta ekonomi. Fungsi ini berguna untuk menghitung lebih cepat 

data-data keuangan.  

Adapun fungsi finansial yang akan dibahas adalah PV, FV, NPV dan IRR. 

1. PV (present value) 

Nilai kini suatu investasi digunakan untuk nilai uang yang disimpan pada saat ini dengan 

tingkat bunga tertentu untuk menghasilkan nilai uang di masa yang akan datang. 

 

Syntax: 

=PV(rate,nper,pmt,[fv],[type]) 

 

• Rate : besarnya suku bungan (dalam prosentase) 

• Nper   : total jumlah periode pembayaran 

• Pmt  : nilai pembayaran 

• FV   : optional, nilai kemudian atau nilai modal pada akhir jangka waktu 

• Type : optional, waktu pembayaran. Tipe 0(nol) jika pembayaran dilakukan di akhir 

periode dan tipe 1 jika pembayaran dilakukan di awal periode 

 

Contoh: 

Tuan A merencanakan untuk menabung sejumlah uang selama 5 tahun. tingkat suku 

bunga simpanan yang berlaku saat ini 18% per tahun dan diasumsikan konstan. dia 

mengharapkan jumlah tabungannya menjadi Rp 70.000.000 (tahun ke-5). berapa jumlah uang 

yang harus ditabung oleh tuan A untuk mencapai jumlah tersebut? 

Jika sel B10:18%; sel C10:5 dan sel E10:70000000  maka jumlah uang yang harus 

ditabung tuan A diisi dengan fungsi sebagai berikut: 

 

• =PV(B10,C10,0,E10) hasilnya adalah 30.597.645 

 

2. FV (future value) 

Digunakan untuk menghitung nilai yang akan datang dengan tingkat bunga tetap dan 

jumlah periode pembayaran. 

 

Syntax: 

=FV(rate,nper,pmt,[pv],[type]) 

 

• Rate  : besarnya suku bungan (dalam prosentase) 

• Nper  : total jumlah periode pembayaran 

• Pmt  : nilai pembayaran 
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• PV  : optional, nilai kemudian atau nilai modal pada akhir jangka waktu 

• Type : optional, waktu pembayaran. Tipe 0(nol) jika pembayaran dilakukan di akhir 

periode dan tipe 1 jika pembayaran dilakukan di awal periode 

 

Contoh : 

Setor per bulan sebesar Rp 317,843 selama 10 tahun. Setelah 10 tahun, akan 

mendapatkan Rp.45.000.000, dengan asumsi tingkat bunga 4%.  

 
Gambar 58. Menggunakan fungsi FV (future value) 

Sebetulnya, dengan asumsi tingkat bunga 4% pa, maka nilai tabungan setelah 10 tahun 

nanti akan sejumlah 46.802.318.  

Penyelesaian: 

Rumus Excel di D8 adalaH: 

 =FV(D6/12,D4*12,D3,1) 

• Rate  : D6/12, rate dihitung per bulan 

• Nper  : periode setoran, yaitu 10 tahun kali 12 = 120 kali 

• Pv  : jumlah setoran sekarang per bulan 

• 1   : pembayaran di awal periode, jika di akhir periode isikan dengan 0. 

 

3. NPV (net present value) 

Digunakan untuk menghitung nilai bersih saat ini dari suatu investasi dengan 

menggunakan tingkat bunga (discount rate), aliran pembayaran yang akan datang (nilai negatif) 

dan pemasukan atau income (nilai positif) 

 

Syntax: 

=NPV(rate, value1,[value2]….) 

• Rate   : tingkat diskonto pada suatu periode 

• Value1, value2  : nilai 1 sampai 244 argumen yang menunjukkan nilai pembayaran dan 

nilai penerimaan 

Contoh: 

• Investasi: Rp. 10.000.000.000,- 
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• Disc.Rate : 25% 

• Net Cash Flow:  

o Tahun ke-1 Rp 3.000.000.000,- 

o tahun ke-2 Rp 3.500.000.000,- 

o tahun ke-3 Rp 4.000.000.000,- 

o tahun ke-5 Rp 4.500.000.000,- 

o tahun ke-6 Rp 5.000.000.000,- 

o tahun ke-6 Rp 5.500.000.000,- 

 

Dasar penentuan kelayakan proyek : 

• Jika NPV > 0, investasi layak, jika NPV < 0, investasi tidak layak 

• Selanjutnya ketik rumus =NPV(B2,B3:B10), penjelasan : 

• B2   : Discount Rate 25% 

• B3:B10  : Net Cash Flow Tahun ke 1 s/d ke 6 

• Hasilnya adalah NPV menjadi 1.289.113.600, NPV > 0, maka proyek layak untuk 

dilaksanakan. 

 

4. IRR (internal rate of return) 

Merupakan indikator tingkat efisiensi dari suatu investasi. Suatu proyek/investasi dapat 

dilakukan apabila laju pengembaliannya (rate of return) lebih besar dari pada melakukan 

investasi di tempat lain (bunga deposito bank, reksadana dan lain-lain). 

Syntax: 

=IRR(value, [guess]) 

• Values : diisi dengan range yang menunjukkan suatu aliran kas, baik aliran kas keluar 

(investasi) maupun aliran kas masuk 

• Guess : optional, tingkat bunga yang diisyaratkan. jika diabaikan maka akan dianggap 

sebesar 10% 

Contoh: 

Tuan B merencanakan untuk membeli apartemen seharga Rp 1.200.000.000. Selama 5 

tahun berikutnya tuan B mengharapakan untuk menerima pendapatan hasil menyewakan 

apartemen tersebut sebesar Rp250.000.000, Rp270.000.000. Rp350.000.000, Rp380.000.000 

dan Rp400.000.000,  asumsi bunga bank sebesar 6%, maka tuan B layak membeli apartemen 

tersebut 
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Gambar 59. Hasil penggunaan fungsi IRR (internal rate of return)
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BAB IX  MS EXCEL 2016 - LANJUTAN 2 
  

 

Topik Utama 

✓ Mahasiswa memahami fungsi PivotTable 

✓ Melakukan laporan dengan teknik penyaringan dan 

pengelompokan data secara mudah 

✓ Membuat grafik dari PivotTable 

✓ Membuat hyperlink dalam MS Excel 

 

Hubungan dengan Bab lainnya 

✓ Bab V dan VI yang membahas tentang Microsoft Excel 2016 

 

 

Pertanyaan Umum 

✓ Apa kegunaan dari PivotTable? 

✓ Kapan anda membutuhkan PivotTable 

✓ Bagaimanakah langkah-langkah menciptakan laporan 

PivotTable? 

✓ Bagaimanakah menampilkan data dengan kriteria tertentu? 

✓ Bagaimana menciptakan grafik dari laporan PivotTable? 

✓ Bagaimanakah membuat link dari satu area kerja ke area kerja 

lainnya? 

  

Praktikum  Membuat PivotTable Report 

 Membuat PivotChart 

 Membuat hyperlink 
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A. MEMBUAT PIVOTTABLE REPORT 

Sebuah laporan PivotTable berguna untuk meringkas, menganalisis, mengeksplorasi, dan 

menghadirkan ringkasan data. Sebuah laporan PivotChart dapat membantu memvisualisasikan 

laporan ringkasan data PivotTable sehingga dapat dengan mudah melihat perbandingan, pola, 

dan tren. Kedua laporan tersebut memungkinkan untuk membuat keputusan penting tentang 

data di perusahaan.  

Laporan PivotTable adalah cara interaktif untuk cepat meringkas data dalam jumlah 

besar. Misalnya, departemen penjualan ingin menganalisa data penjualan dalam beberapa sudut 

pandang yang berbeda seperti dari sudut pandang wilayah, produk, maupun tenaga penjualan. 

Gunakan laporan PivotTable untuk menganalisis data numerik secara rinci dan untuk 

menjawab pertanyaan tak terduga tentang data yang dimiliki. Sebuah laporan PivotTable ini 

dirancang khusus untuk: 

• Query data dalam jumlah besar dalam banyak hal user-friendly. 

• Subtotal dan menjumlahkan data numerik, meringkas data dengan kategori dan 

subkategori, dan menciptakan perhitungan kustom dan formula. 

• Pindah baris untuk kolom atau kolom ke baris (atau "berputar") untuk melihat ringkasan 

berbeda dari sumber data. 

• Penyaringan, pemilahan, pengelompokan, dan kondisional format subset paling berguna 

dan menarik data untuk memungkinkan fokus pada informasi yang diinginkan. 

• Menyajikan laporan online atau cetak ringkas, menarik, dan jelas. 

 

B. MEMBUAT PIVOTCHART REPORT 

Sebuah laporan PivotChart memberikan representasi grafis dari data dalam laporan 

PivotTable, yang dalam hal ini disebut laporan PivotTable terkait. Sebuah laporan PivotChart 

bersifat interaktif, yang berarti bahwa bisa memilah dan menyaring untuk menunjukkan subset 

dari data PivotTable. Ketika membuat laporan PivotChart, filter laporan PivotChart yang 

ditampilkan di area grafik sehingga dapat memilah dan menyaring data yang mendasari laporan 

PivotChart. Perubahan yang dibuat pada tata letak lapangan dan data dalam laporan PivotTable 

terkait akan segera tercermin dalam laporan PivotChart. 
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Gambar 60. Laporan PivotTable 

 

 Tabel diatas memiliki kaidah database dengan ciri khas sebagai berikut: 

1. Header 

• Diletakkan pada baris 1 dan hanya terdiri dari 1 baris saja 

• Setiap kolom Excel berisi sebuah header, jadi kolom A milik date dan date pasti 

hanya di kolom A Excel, begitu juga dengan kolom lainnya 

• Ditata rapat (dari kiri ke kanan mulai A1), sehingga tidak ada kolom kosong 

tanpa teks header 

• Setiap cell header berisi data tertentu dan tidak ada dua atau lebih kolom berisi 

suatu data tanpa header 

• Tidak ada header yang di-merge cell, baik merge cell baris maupun merge cell 

kolom 

• Setiap header menjadi nama setiap kolom data 

2. Kolom 

• Setiap kolom data memiliki nama kolom 

• Setiap kolom berisi data dengan tipe data yang sama 

• Tidak ada pengaturan alignment pada kolom, agar tampak jelas kesamaan tipe 

data dalam kolom tersebut 

3. Records 

• Record pertama diletakkan tepat pada baris 2 

• Tidak ada baris kosong diantara dua record, jadi minimal ada satu field dalam 

record yang memiliki nilai 

• semua field terisi penuh jika seharusnya memiliki suatu nilai tertentu, meskipun 

nilainya sama dengan record sebelumnya  

 

1. Membuat PivotTable dari data lembar kerja 

 

1. Siapkan raw data seperti yang tertera pada gambar diatas (Laporan PivotTable)  
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2. Untuk menggunakan data pada sebuah tabel sebagai sumber data, → header pertama 

sampai record terakhir sehingga seluruh data terblock 

3. Pastikan range memiliki judul/header dan tidak boleh ada baris yang kosong dalam tabel. 

4. Pada tab Insert > grup Tables >  icon PivotTable 

 
5. Ketika muncul kotak dialog Create Pivot Table: pastikan tabel/range terisi $A$1:$G$13 

>  OK 

 
Gambar 61. Menentukan rentang tabel dalam PivotTable 

 

6.  OK pada kotak dialog Create PivotTable, sehingga akan muncul pada sheet2 sbb: 
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Gambar 62. Tampilan PivotTable Field List 

7. Tampak kotak dialog PivotTable Field dimana semua header pada tabel muncul sebagai 

daftar field yang akan dibuat sebagai kriteria report 

 

2. Membuat report PivotTable berdasarkan kriteria/filter 

 

Buatkan report berdasarkan semua item untuk penjualan setiap unit employee masing-

masing region, dengan langkah-langkah sebagai berikut: 

1. Drag field TIPE BARANG dan drop ke kotak Filter 

2. Drag field NAMA SALES dan drop ke kotak Row  

3. Drag field NAMA BARANG dan drop ke kotak Row, pastikan berada di bawah NAMA 

SALES 

4. Drag field HARGA JUAL SATUAN, JUMLAH PENJUALAN dan TOTAL 

PENJUALAN drop ke kotak Values atau dengan cara mencentangnya saja 

5. Hasil dari langkah-langkah tersebut akan terlihat seperti gambar berikut ini: 
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Gambar 63. Report menggunakan PivotTable 

Pada saat anda ingin melihat hasil report PivotTable untuk item HG/RG/MG, maka cukup 

 di sel B1 dan pilih item HG/RG/MG. Demikian juga berlaku untuk multiple item, dapat 

dipilih lebih dari satu item. 

Info  

PivotTable Fields (Areas) Filter biasanya untuk data berupa waktu atau tanggal  atau 

lainnya. 
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Row dan Column biasanya berupa data Non Numerik 

Value biasanya berupa data Numerik 

 

 

3. Membuat report PivotChart berdasarkan report PivotTable 

 

Dengan menggunakan tabel Piv-1, buatkan report PivotTable di sheet2 dengan:  

• Rows: Nama Sales dan Tipe Barang  

• Values: Jumlah Penjualan 

Jika sudah, maka siapkan report PivotChart berdasarkan report PivotTable dengan cara 

sebagai berikut: 

1. Posisi sel bebas, selama ada didalam sheet2 

2.  pada tab Insert > grup Charts >  icon Column  

3. Pada 2 – D bar >  Clustered Bar 

4. Maka akan tampak secara otomatis seperti dibawah ini: 

 
Gambar 64. Membuat PivotChart dari PivotTable 

 

C. MEMBUAT HYPERLINK 

Excel mempunyai fungsi hyperlink berupa teks atau gambar yang jika diklik akan 

menghubungkan komputer ke sebuah halaman web, ke sebuah file dalam harddisk, atau 
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mengaitkan sebuah file dalam jaringan lokal. Dengan kata lain dengan mengklik shortcut yang 

telah dibuat, dapat membuka dokumen lain yang tersimpan pada harddisk, network server, 

intranet dan internet. 

 

Berikut adalah contoh untuk membuat hyperlink antar sheet dalam sebuah file: 

1. Buka file case-hyperlink.xlsx (Mintalah kepada Instruktur Lab. untuk mendapatkan file 

tersebut) 

File Background  

Download Download file case-hyperlink.xlsx: 

  program Google Chrome > pada Address bar, masukkan alamat 

website: 

 www.tsm.ac.id/download/labaplikom/excel/ 

 

2. Maka akan tampil sebuah worksheet dalam file MS Excel seperti dalam gambar berikut: 

 
Gambar 65. Isi file latihan hyperlink di MS Excel 

3.  sel A5 > pada tab menu:  tab Insert > grup: Links >  ikon Hyperlink 

4. Maka akan muncul sebuah kotak dialog Insert Hyperlink seperti pada gambar berikut ini: 
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Gambar 66. Contoh gambar menentukan tujuan hyperlink di MS Excel 

5. Pada kotak dialog Insert Hyperlink:  pada field: Type the cell refference > Ganti A1 

menjadi A4 

6. Pada field: Or select a place in this document >  Sheet2 > klik tombol OK 

7. Maka di sel A5 akan berubah warna dan muncul garis bawah, hal ini menandakan bahwa 

sel A5 tersebut bertautan dengan sheet2 di sel A4 

8. Lanjutkan hal yang sama dengan sel A6 dan A7, yaitu dengan melakukan: 

a. Sel A6 → cell reference ke A10 di sheet2 

b. Sel A7 → cell reference ke A15 di sheet2 

9. Sekarang anda sudah menghubungkan dua sheet yang berbeda yaitu sheet1 dan sheet2. 

10. Lakukan uji coba dengan  pada sel A5, maka sheet2 akan terbuka dan posisi sel ada di 

A4. 
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BAB X  MS POWERPOINT 2016 
  

 

Topik Utama 

✓ Mahasiswa memahami kegunaan dari program MS Powerpoint 

✓ Mahasiswa mengenal bagian-bagian umum MS PowerPoint 

✓ Mahasiswa mengetahui penggunaan theme templates 

✓ Mahasiswa mengetahui cara menyisipkan dan mengolah tabel, 

chart, WordArt, shape, SmartArt  

✓ Mahasiswa terampil menata dan menyisipkan objek-objek 

seperti ClipArt, Picture, SmartArt, dan Shape 

✓ Mahasiswa terampil memilih dan menggunakan slide transition  

✓ Mahasiswa mengetahui cara membuat link untuk berpindah dari 

satu slide ke slide lainnya dengan cepat 

✓ Mahasiswa mampu memanfaatkan fitur Notes Slide 

✓ Mahasiswa mengenal jenis-jenis pencetakan presentasi dan 

bagaimana menjalankan slide presentasi 

 

Pertanyaan Umum 

✓ Apa kelebihan dan kegunaan MS PowerPoint dibandingkan 

program lainnya didalam kelompok MS Office? 

✓ Objek apa saja yang bisa kita tampilkan didalam slide presentasi 

kepada audience? 

✓ Apakah audience menyukai presentasi yang ditampilkan 

dengan atraktif? 

✓ Bagaimana merancang presentasi sehingga informasi yang 

ingin disampaikan presenter mudah diikuti dan dibaca? 

✓ Bagaimana presenter menggunakan strategi penggunaan notes 

dan membagikan hasil cetak materi kepada audience untuk 

menyampaikan informasinya? 

Praktikum  Mengenal MS PowerPoint dan fitur-fitur baru di MS PowerPoint 2016 

 Mengenal bagian-bagian dari window MS PowerPoint 2016 

 Membuat slide dengan menggunakan theme yang disediakan 

 Menyisipkan dan mengolah tabel, Symbol, WordArt, Chart, Shape, dan 

SmartArt 

 Menyisipkan gambar, link,  dan nomor slide 

 Mengolah slide transition, efek animasi, notes, dan mencetak materi 

presentasi 

 Menjalankan slide presentasi kepada audience 
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A. PENGENALAN DASAR MS POWERPOINT 2016 

PowerPoint adalah sebuah program yang dibangun oleh Miscrosoft, dan dikenal dengan 

nama MS PowerPoint. MS PowerPoint 2016 merupakan kelanjutan dari MS PowerPoint 

versi-versi sebelumnya, yang tentu saja setiap versi yang baru diberikan kemudahan dan fitur-

fitur yang baru. 

MS PowerPoint dapat kita temukan didalam kelompok program Microsoft Office. 

Didalam software ini memungkinkan untuk membuat slide demi slide yang akan ditampilkan. 

MS PowerPoint sering digunakan untuk membuat presentasi bisnis, selain itu didunia 

pendidikan bisa digunakan untuk penyampaian materi mengajar maupun presentasi untuk tugas 

dan ujian akhir. 

 

B. MEMBUKA PROGRAM MICROSOFT OFFICE POWERPOINT 2016 

Berikut langkah-langkah untuk membuka program MS PowePoint 2016: 

•  Start > Microsoft Office PowerPoint 2016 

Berikut Tampilan MS PowerPoint 2016 

 
Gambar 67. Tampilan awal MS PowerPoint 
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Berikut bagian-bagian dari fitur MS PowerPoint 2016: 

 
Gambar 68. Bagian-bagian umum dari window MS Office 2016 

1 Quick Access Toolbar 8 Slide 

2 Title Bar 9 Customize Status Bar 

3 Tab Menu 10 Zoom Slider 

4 Pengatur Windows 11 Slide Show 

5 File: yang berisi perintah-perintah manajemen 

file 

12 Slide View Mode 

6 Kelompok Tool 13 Comments: untuk menambah 

pesan 

7 Slide Pane 14 Notes: untuk membuat catatan 

1 
2 

3 

4 

6 

7 

9 

8 

11 10 13 12 

5 

14 
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Bagian-bagian dasar dari layout yang bisa dimasukkan didalam slide presentasi MS 

PowerPoint 2016: 

 
 

C. MEMBUAT PRESENTASI 

 

Ada beberapa cara dalam merancang slide presentasi, bisa dengan merancang dengan 

memulainya dari blank, atau dengan mengambil rancangan dari Theme yang disediakan, atau 

bisa juga dengan mengambil slide presentasi dari template. 

 

1. Membuat presentasi dengan menggunakan Theme 

 

Buatlah sebuah presentasi baru dengan cara: 

•  Start >  Microsoft Office PowerPoint 2016 >  Blank Presentation 

• Setelah terbuka sebuah slide presentasi kosong, kita akan membuat disain presentasi 

dengan mengambil dari Themes: 

•  tab menu: Design > pada grup Themes:  salah satu Theme > maka secara otomatis 

akan tercipta suatu rancangan slide presentasi sesuai dengan Theme yang dipilih. 

 
Memodifikasi Master Slide 

•  tab menu: View > pada grup Presentation Views:  ikon Slide Master ( ) maka 

pada area kerja slide akan tampil desain master untuk slide yang akan digunakan. 
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• Lakukanlah beberapa perubahan seperti warna teks, bullet, maupun slide footer sesuai 

dengan keinginan anda. 

• Setelah mencoba beberapa perubahan, tutuplah kembali Slide Master dengan cara: 

o  tab menu: Slide master > pada grup Close:  ikon Close Master View (

) 

 

 
Gambar 69. tampilan Slide Master 

Menyimpan file latihan 

• Simpanlah file latihan PowerPoint pertama anda diatas: 

•  File >  Save > buatlah folder “latihan PowerPoint 2016” di direktori latihan anda 

> pada File Name:  “latihan MS PowerPoint - 1.pptx” 

  

Tab master: slide layout 
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D. PRAKTIKUM MS POWERPOINT 2016 

 Berikut adalah gambar slide yang akan coba Anda buat: 
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Berikut ketentuan untuk membuat slide seperti di atas: 

1. Masukan Clipart/Gambar di Slide Master 

2. Sesuaikan Slide Number 

3. Sisipkan Shape, SmartArt, Tabel, dan Chart 

4. Sisipkan Hyperlink 

5. Gunakan Efek Animasi dan Slide Transisi 

E. Tugas Kelompok 

1. Buatlah sebuah presentasi sebanyak jumlah anggota kelompok (cover tidak dihitung) 

2. Rundingkan materi presentasi  dengan Instruktur 

3. Gunakan seluruh hal yang telah dipelajari pada Bab 10 

4. Latihan Presentasi
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